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1.

Introduction

This guide provides an overview and a description of
the basic skills and terminology required to operate
the following Elixir applications:
ElixiSys Desktop, a Windows-based user interface from which you can easily launch Elixir applications, such as ElixiForm, ElixiFont, and
ElixiGraphics. The ElixiSys Desktop also enables
quick access to Elixir converters that convert
form, font, document, and graphics files between
Xerox, Elixir, and other formats. You can edit
Elixir-format files using the appropriate Elixir application (ElixiForm, ElixiFont, or ElixiGraphics)
and convert them back to the original or a different format using the ElixiSys Desktop.
ElixiForm, a Windows-based WYSIWYG forms
creation package used for creating or editing
Elixir-format forms which you can then convert to
Xerox and other formats using the ElixiSys
Desktop.
ElixiFont, a sophisticated Windows-based font
editor used for creating or editing Elixir-format
fonts which you can then convert to Xerox and
other formats using the ElixiSys Desktop.
ElixiGraphics, a Windows-based bitmap editor
used for creating or editing Elixir-format graphics
which you can then convert to Xerox and other
formats using the ElixiSys Desktop.
For information on how Elixir applications fit into the
forms creation process, see the "Forms creation process" section of this chapter.
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Each Elixir application has a user guide that you can
refer to for more detailed information.
For information regarding error and operational messages, see "Appendix A, Troubleshooting".

Release notes
Release notes appear at the beginning of the Elixir
software install process, so that you can review each
entry before performing the complete installation.
Once the software is installed, release notes can be
accessed from the Help menu of the application. Release notes are formatted for viewing in Notepad or
Wordpad. They have a txt file extension and are
found in the drive:\ELIXIR \RELNOTES directory.

Customer support
Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.
If you have any problems running or using Elixir applications, call your customer support center telephone
number in your area for help. When calling, you will
be asked for the following information:
your name, organization, telephone number, and
address
the name and version number of the Elixir
application
a complete description of the problem, including
any error messages displayed on your monitor or
printed on your printer.
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Xerox customer support center
If you have purchased your Elixir product directly from
Xerox Corporation then you should contact the Xerox
customer support center telephone number provided
by Xerox.
For future reference, please record your Xerox customer support number below.

Xerox customer support center telephone
Elixir customer support centers
If you have purchased your Elixir product directly from
Elixir Technologies then contact the support center for
your region.
North and South America
+1 805 641 5900 ext. 3
Asia Pacific
+92 (0) 51 206182
Europe
+420 2 2431 13877
The U.S.A. Elixir Customer Support Center provides
telephone technical assistance for Elixir users Monday
through Friday from 6:30 a.m. to 5:00 p.m. Pacific
Standard Time.
You can contact Elixir support by accessing the Elixir
World Wide Web page (and selecting [Contact Support]) at http://www.elixir.com. Please complete the
question form.
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Elixir Web site support
The Elixir Web site at http://www.elixir.com offers the
following resources:
Raise a question for Elixir Support.
Find answers in the list of Frequently Asked
Questions.
Review the latest Tips and Techniques for increasing productivity using Elixir software.
Download new releases and the latest patches.
View Release Notes for the latest available
features.
Learn in the user newsgroup how others are using Elixir products.
Sign up for an Elixir Learning Program.

Who should use this guide
This guide is intended for users who are familiar with
Windows and who want to install and use the ElixiSys
Desktop and associated applications: ElixiForm, ElixiFont, and ElixiGraphics.

System requirements
The following sections describe the hardware and
software requirements for running the ElixiSys Desktop, ElixiForm, ElixiFont and ElixiGraphics.
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Hardware
Recommended PC configuration: Pentium (or
100% compatible), with at least 133 MHz processor
(or the fastest commercially available processor); 32
MB RAM, 500+ MB hard drive, one CD-ROM drive.
Additional requirements:
any monitor with driver software supporting Windows in VGA or SVGA
any Windows compatible mouse
One of the following devices, for communicating
with Xerox printers:
Any PC-to-mainframe or communications
board that supports binary file transfers (such
as IBM PC3270, IRMA FT/3270, or AS/400
PC communications packages).
Any 9-track, 1600 or 6250 bpi tape drive with
a Overland TX-8 controller card (such as the
Qualstar with the Overland TX-8 controller
card).
For users with compatible PCs, you can
transfer files between your PC and Xerox production printer. Refer to the ElixiSys Desktop
User Guide.
One or more of the following optional peripheral
devices:
Xerox production or distributed printer
HP LaserJet IV or compatible PCL 4 printer.
(HP PCL 4 is the format supported), or PostScript compatible
Any digital scanner and associated software
with ability to create .PCX or .TIF images at
300 x 300 dpi.
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Software
Software requirements: Microsoft Windows 95, Wincows 98 or Windows NT 4.0 or later.
While we make every effort to ensure the proper operation of our software, some problems cannot be resolved due to differences in the operating systems.

Toolsets
After installation, you can select which toolset to use.
The following table describes the appropriate toolsets
to select depending on your Elixir product.
Information for 4.00 Elixir Edition products is for reference purposes only.
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Desktop 4.00 Toolsets

Elixir 4.00 Product(s)

Xerox Black and White
or
Xerox H/L Color

ElixiForm
ElixiSys Desktop

Xerox H/L Color and B&W

ElixiForm
ElixiSys Desktop for HighLight Color

Xerox H/L Color and B&W

ElixiForm
ElixiSys Desktop
ElixiSys HighLight Option

Xerox Distributed Printers

ElixiSys Converter for Xerox Distributed Printers
ElixiForm Editor for Xerox Distributed
Printers

After installation, you can check your toolset from the
ElixiSys Desktop by clicking on the System menu and
selecting [Toolset]. The Desktop Toolsets dialog box
displays the list of toolsets. Make sure the correct
toolset for your product is selected.

Conventions
This section describes the following:
display conventions
typographical conventions
mouse operations.
Display conventions
The ElixiSys Desktop, ElixiForm, ElixiFont and ElixiGraphics, all adhere to Microsoft Windows conventions for using menus, menu commands, dialog
boxes, command buttons, icons, and a mouse. See
your Windows manual for more information.
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Typographical conventions
The following typographical conventions are used
throughout this guide and in all Elixir product guides:
Keystrokes are shown enclosed in < > (angle
brackets). For example, <Enter>.
Key combinations are denoted by a plus sign between keys. For example, <Shift> + <F1> indicates to simultaneously press the <Shift> and the
<F1> keys.
Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example,
Pull down the File menu and select [New].
Command buttons that you press are also enclosed in [ ] (square brackets). For example,
Click on [OK].
Commands, options, actions, and parameters
that require description are shown in bold followed on the next line by the description. For example:
Delete
Deletes the selected files.
Steps in a procedure are shown in numbered bold
paragraphs. For example,
1.

At the prompt, enter the file name and
extension.
Comments relating to a step (such as this paragraph) are shown in regular text following the bold
paragraph.
Commands you enter at the DOS prompt are
shown in larger text. Within DOS commands,
variable names and keys you press are shown in
italics. For example:

CD \ELIXIR <Enter>
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Mouse operations
You can perform most operations in Elixir applications
by using the mouse. The terminology is similar to
other Windows based applications.
Mouse operations are performed using the left or right
mouse button, unless the right mouse button is
specified.
The following mouse related terms are used in this
guide:
click
to momentarily press and release the left mouse button once. A right mouse button click is specified
where necessary. For example,
Click on the right mouse button to finish entering text.
double-click
to click the left mouse button twice in rapid
succession.
drag
to click and hold the mouse on an item and move the
item with the mouse.
drag and drop
to drag an item as above, then release the mouse button once the item is positioned over a certain area. If
the selected object is a file and the destination is a directory, the file is copied to the directory.
object
a selectable item on the screen.
open
to point and double-click on an object -- the effect of
this operation depends on the object.
point
to move the mouse to position the screen pointer on
an area of the screen.
select
to point to an object and click the mouse -- this usually
highlights the object.
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<Alt>click
to hold down the <Alt> key while clicking the left
mouse button -- this allows you to select a range of
files in a window.
<Ctrl>click
to hold down the <Ctrl> key while clicking the left
mouse button -- this allows you to select individual
files from a group in a window.
<Shift>click
to hold down the <Shift> key while clicking the left
mouse button -- this allows you to select more than
one object at a time.

On-line Help
Elixir software uses the Microsoft Windows Help program to provide on-line help for all functions.
For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.
The Help files included with your Elixir software include graphics created using screen drivers with large
fonts. If you use a screen driver with small fonts, the
Help file graphics may not display clearly. For optimum graphics display, use a screen driver that uses
large fonts.
You can display on-line Help in the following ways:
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Bubble help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.
Quick help
Enable the quick help function by selecting the [Show
Quick Help] option in the Usage Switches (or Preferences for ElixiGraphics) dialog box. When you move
the screen pointer over an icon on the screen, a short
description of the icon function displays in the message area of the screen. During certain operations a
message about the function you are performing also
displays in the message area. To see these operational messages, disable the quick help feature.
Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays. If no
specific topic is available, the Help table of contents
displays.
Help menu
Select the Help menu from the menu bar and choose
one of the displayed topics.
Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic. Under Windows 95 and Windows NT, right-click on a dialog box option to display
an associated Help topic.
Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps. When you click on a
pop-up topic, a box displays within the current Help
topic with additional information. When you click on a
jump, a different, associated Help topic displays.

ELIXIR GETTING STARTED GUIDE
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Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots." Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions). Move the cursor over a hypergraphic until a hand displays, then click on this hot
spot to display a pop-up topic, or a "jump".
To close a pop-up topic, click the mouse button. To
return to the original Help topic from a jump, click on
<Back> in the Help File menu.

Using Online documentation
This section describes how to use PDF online documentation, including navigating through the online
guides and printing the guides. Acrobat Reader is
provided with the online documentation. Information
about using the Acrobat Exchange program is included for users who have licenses for that program.
Accessing online guides
The PDF online documentation is copied to the
drive:\Elixir\help\pdf directory during the installation of
Elixir Suite for Xerox. If you didn't choose to copy the
PDF online documentation during the installation, you
can view a complete list of the files by clicking on the
Windows [Start] button and selecting Programs>Elixir
Applications>Elixir Suite for Xerox. Once the application is launched, click on the Help menu and select
Release Notes. Wordpad displays a current list of
supporting documents and the directories where they
can be found on CD-ROM.
When the appropriate PDF file is accessd the Acrobat
Reader program is launched and the List of Online
Guides is displayed. Click on a guide to view its table
of contents and jump to individual chapters.
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The following list of PDF files and associated document names are installed in the drive:\Elixir\help\pdf
directory.
StartXRX.pdf - Getting Started User Guide
DeskXRX.pdf - ElixiSys Desktop User Guide
FormXRX.pdf - ElixiForm User Guide
FontXRX.pdf - ElixiFont User Guide
GraphXRX.pdf - ElixiGraphics User Guide
PHXRX.pdf - PageHandler User Guide
DTAG.pdf - DocuTag User Guide
DMerge.pdf - DataMerge User Guide
AppVIPP.pdf - Elixir AppBuilder for VIPP User
Guide
PDNT.pdf - Elixir PrintDriver for NT User
Guide
PDXRX.pdf - Elixir PrintDriver User Guide
Transfmr.pdf - Elixir Transformation Suite
User Guide
Viewer.pdf - ElixirViewer User Guide
Elxscan.pdf - ElixiScan User Guide
Navigating in online guides
After loading a PDF document in Acrobat Reader or
Exchange program (as described above), you can
navigate through the online guide by clicking on the
following:
TOC chapter titles - jumps to the beginning of the
chapter indicated.
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[Next Page] or [Previous Page] in the Toolbar - jumps
to the next or previous page of the online guide (alternatively, you can use the <Page Up> and <Page
Down> keys).
[Go Back] in the Toolbar - returns to your previous
location.
[First Page] in the Toolbar - returns to the opening
screen of the online guide.
Bookmarks
All chapter headings in the table of contents are
marked to jump to a specific chapter or the index.
To use the bookmarks:
1.

Go to the table of contents for the book.

2.

Click on the [Bookmark] icon for the chapter
that you want jump to.

Word find
This option finds a key word or phrase in the current
document.
To use Word Find in a document:
1.

Click on the [Find] icon in the Toolbar.
The Adobe Acrobat Find dialog box displays.

2.

Enter the desired search text and click on
[Find].
The Acrobat Find dialog box closes and the first
occurrence of the text is highlighted.

3.
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To find more occurrences of the same text,
click on the [Find] icon in the Toolbar and
then click on [Find Again] in the Find dialog
box.
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Page scrolling
You can move a document on the screen to view portions of it not visible in the window, or read a document which contains article threads by clicking the
mouse to scroll through the document without using
the scroll bar.
To move a document on the screen for viewing (functional only when the document displays wider than the
document window):
1.

Click on the [Hand] icon in the Toolbar.

2.

Hold down the mouse button and drag the
cursor in the desired direction.

To follow the flow of text in a document that contains
article threads (automatic text flows):
1.

Click on the [Hand] icon in the Toolbar.

2.

If the document contains article threads, a
“down” arrow displays on the Hand icon.

3.

Position the hand-shaped cursor over a
paragraph and click on the paragraph to begin
reading.

4.

Continue clicking to follow the flow of text.

Zoom in/out
To magnify the size of the page display, click on the
Zoom icon in the Toolbar, then click in the Work area.
Each click resizes the view by a factor of two.
To reduce the size of the page display, click on the
Zoom icon in the Toolbar, then hold down the <Ctrl>
key and click in the Work area.
You can also click on the [%] button at the bottom of
the screen and select a zoom percentage from the
pop-up list.
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Printing online guides
You can print individual chapters or an entire book to
PostScript or HP printers:
1.

Open the file.

2.

Select File>Print.
The Print dialog box displays.

3.

Select your printing options and click on [OK].

Organization of this guide
Chapter 1, "Introduction," provides an overview of
Elixir software and documentation and describes the
hardware, software, and memory required for installing and using Elixir software.
Chapter 2, "Installation," describes how to install Elixir
software.
Chapter 3, "Desktop basics," provides an overview of
the ElixiSys Desktop and instructions on how to perform basic Desktop operations.
Chapter 4, "ElixiForm basics," provides an overview of
ElixiForm and instructions on how to perform basic
ElixiForm operations.
Chapter 5, "ElixiFont basics," provides an overview of
ElixiFont and instructions on how to perform basic
ElixiFont operations.
Chapter 6, "ElixiGraphics Basics," provides an overview of ElixiGraphics and instructions on how to perform basic ElixiGraphics operations.
Appendix A, "Troubleshooting," provides troubleshooting procedures, and lists all operational and error
messages issued by the Elixir Suite for Xerox
products.
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Starting Elixir applications
This section describes how to start the ElixiSys Desktop and associated applications (ElixiForm, ElixiGraphics, and ElixiFont) after installation.
Using Windows 95, Windows 98, or Windows
NT: Start the ElixiSys Desktop by clicking on the
[Start] button and choosing Programs> Elixir Applications> Elixir Suite for Xerox.
The ElixiSys Desktop displays.

Figure 1-1. ElixiSys Desktop window
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Note: If you are using a monochrome monitor and
have difficulty reading the title bar text, pull down the
System menu and select [Usage Switches]. In the
Usage Switches dialog box, select [Monochrome
Monitor].
To start ElixiForm, ElixiGraphics, or ElixiFont doubleclick on the corresponding ElixiForm, ElixiGraphics, or
ElixiFont icons on the ElixiSys Desktop.
For example, double-click on the ElixiGraphics icon to
start ElixiGraphics and display the ElixiGraphics
window.

Figure 1-2. ElixiGraphics window
Using Windows colors and fonts
You can change from Elixir colors and fonts to Windows
colors
and
fonts
by
editing
the
drive:\WINDOWS\ELX.INI file using any text editor,
for example Notepad.
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To use Windows colors, go to the [NCDraw] section and change the "MenuColorScheme=Elixir"
entry to "MenuColorScheme=Windows"
To use Windows fonts, create a [Fonts] section
and add the following entry: "ScreenFontType=1".
To use the same fonts as in previous Elixir versions, change the entry to the following:
"ScreenFontType=0".

Exiting Elixir applications
To exit the ElixiSys Desktop or any of its associated
applications you can do one of the following:
double-click on the [Close] button at the top left of
the Elixir application.
press <Alt> + <F4>.
press <Alt> + <X>.
pull down the File menu and select [Exit].
Click on the [X] at the top right corner of the Elixir
application.

Forms creation process
This section describes the forms creation process and
how Elixir applications fit in the process.
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Forms creation overview
A form is a single-page document that contains elements such as lines, boxes, text, and graphics. The
following steps outline the forms creation process:
1.

Input/Conversion
Collect resources such as fonts and graphics,
and convert them to a format that you can edit or
use in a composition package.

2.

Editing and composition
Organize and structure the resources.

3.

Data integration
Use the resources in a form.

4.

Proof-printing
Print the form on a proof-printer to ensure that all
resources print correctly.

5.

Revising
Review the proof-print and make any necessary
changes.

6.

Final printing and distribution
Print multiple copies of your form on a production
printer and distribute these forms to the target
audience.

How Elixir fits in the forms creation process
The following steps show how you can use Elixir applications in the forms creation process. Each step provides references to the chapters and user guides
where you can find more detailed information.
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To create a form using Elixir applications:
1.

Gather the resources, such as fonts and
graphics, that you want to use in your
document and copy them to the appropriate
input Elixir directories.
See the "Elixir folders" chapter of the ElixiSys
Desktop User Guide.

2.

Convert resources to Elixir-format using the
ElixiSys Desktop.
If you plan to proof-print, you must also create
printer versions of your fonts.
See the "Desktop basics" chapter of this user
guide or the "File conversions" chapter of the ElixiSys Desktop User Guide.

3.

Use the appropriate Elixir application to edit
or create resources.
For more information about editing or creating
fonts, see the "ElixiFont basics" chapter of this
user guide or the "Creating and editing fonts"
chapter of the ElixiFont User Guide.
For more information about editing or creating
graphics, see the "ElixiGraphics basics" chapter
of this user guide or the "ElixiGraphics basics"
chapter of the ElixiGraphics User Guide.

4.

Create a form in ElixiForm using
resources created in the previous steps.

the

See the "ElixiForm basics" chapter of this user
guide or the "ElixiForm basics" chapter of the
ElixiForm User Guide.
5.

Proof-print your form to verify that your
resources print correctly.
See the "ElixiForm basics" chapter of this user
guide, or the "ElixiForm basics" chapter of the
ElixiForm User Guide.
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6.

Convert your form to the appropriate printer
format using the ElixiSys Desktop.
See the "Desktop basics" chapter of this user
guide, or the "File conversions" chapter of the
ElixiSys Desktop User Guide.

7.
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Transfer your form onto the selected printer
and print your form.

ELIXIR GETTING STARTED GUIDE

2.

Installation

This chapter describes procedures for installing Elixir
software for the first time, and over an existing
version.
If you have purchased your Elixir product directly from
Xerox Corporation then you should follow instructions
in the Read-Me card accompanying your software
upgrade.

Before installation
Read the notes supplied with the Elixir installation program before installing or reinstalling the Elixir software, or before using a tape drive.
Complete the software licensing process (See the
"Product Registration" section).
All Elixir applications described in this guide are
installed using the supplied CD-ROM.
First time installation (of a Desktop application)
requires at least 26 MB of free space on your
hard disk drive. Selecting multiple applications
will require additional disk space. Reinstallation
requires less disk space as the installation procedure overwrites existing Elixir application files.
Each time you reinstall Elixir software, you overwrite existing program files and utilities with new
ones. You should select backup files when
reinstalling.
To avoid any possible conflicts, exit all other applications before installing Elixir software.
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If you want to abort installation at any time during
the process, click on the [Cancel] button from the
install screen or press the <Esc> key. You will be
prompted to abort.
ElixiForm is not downward compatible.
Tape drive configuration
If you are using a Qualstar tape unit, copy the
TAPE_MT0.SYS file (and, if provided, the
LDIMG.EXE file) from the driver diskette (supplied by
Qualstar) to your root directory.
Add the following line to your CONFIG.SYS file.
DEVICE= TAPE_MT0.SYS 8
If LDIMG.EXE is included on the Qualstar driver
diskette, add the following command to your
AUTOEXEC.BAT file:
LDIMG
Use any text editor in non-document mode (to generate ASCII text) to add text to the CONFIG.SYS and
AUTOEXEC.BAT files. Note that you must reboot
your PC for any changes in your CONFIG.SYS and
AUTOEXEC.BAT files to take effect.

Product Registration
Elixir products no longer require ElixiKey hardware devices attached to your parallel port. Elixir products
now utilize soft key technology. This new licensing
process validates your license agreement with Elixir
and places a file (password.epw if an Elixir customer,
or License.dat if a Xerox customer) on your
workstation.

2-2
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Version 4.00 implements Elixir's new licensing process and discontinues use of the current hard keys. All
customers must register/re-register software license(s) by using the Elixir registration program provided
with the software.
Each product installed is assigned to a specific pc.
This pc number, your customer number, and password are required. This information is provided when
you purchase Elixir software or when you upgrade to
version 4.00 of Elixir products.
If you are an Elixir customer, registration can be completed automatically if you have an internet connection
on your workstation. If you are a Xerox customer you
must contact Xerox to register your products.
This section describes the registration process for
those customers who have purchased their Elixir
products form Elixir Technologies.
The following scenarios describe the registration
process for Elixir customers. Xerox Corporation will
provide a separate document that describes registering your products with Xerox.
you are a new customer and will use Soft Key
registration
you are an existing customer and will change to
Soft Key registration
Elixir Product Registration screen
Make your selections according to your needs and go
to the appropriate section for further procedures.

ELIXIR GETTING STARTED GUIDE

2-3

INSTALLATION

Figure 2-1. Elixir Product Registration screen
Using the internet
You can register and download all registration files via
the Elixir Product Registration program. There are
two ways to register your products using the Internet:
down load the product registration file directly to
the Elixir PC via the Internet (see "Registering as
a new customer via the internet")
download the product registration file to another
machine and move it to the Elixir PC (see "Downloading via the internet to a non-Elixir PC")
Registering as a new customer via the internet
You will receive a "Customer Activation Letter" with
your product(s) ordered. The registration process
should be completed before installing your software.
The installation CD will launch and install the Registration Program.
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To install the registration program on your Elixir PC:
1.

In the Software Registration screen, click on
[Next].

2.

Select the drive and click on [Next].

3.

In the Start Registration Process screen, click
on [Install].
The password file will be installed and your system configured.

To complete registration:
1.

In the Elixir Product Registration "Welcome"
screen, select [Next].
Your machine serial number displays.

2.

Enter your customer number (from Activation
Letter), then click on [Next].

3.

Enter your password and the PC number you
want to register, then click on [Next].

4.

Select [Prepare and download my initial
product license registration. This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next].

5.

In the Download Password screen, click on
[Yes].
The system displays your customer information
and you must verify that it is correct.

6.

When the screen displays the registration
information, click on [Save]. You may also
print this screen for reference or to send to
Elixir.

The application installation process will begin, see the
"Installation" section.
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Downloading via the internet to a non-Elixir PC
You will receive a "Customer Activation Letter" with
your product(s) ordered. The registration process
should be completed before installing your software.
The installation CD will launch and install the Registration Program.
To install the registration program on your Elixir PC:
1.

In the Software Registration screen, click on
[Next].

2.

Select the drive and click on [Next].

3.

In the Start Registration Process screen, click
on [Install].
The password file will be installed and your system configured.

To complete registration:
1.

In the Elixir Product Registration "Welcome"
screen, select [Next].
Your machine serial number displays.
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2.

Enter your customer number (from Activation
Letter), then click on [Next].

3.

Enter your password and the PC number you
want to register, then click on [Next].

4.

Select [Prepare and download my initial
product license registration. This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next].

5.

In the Download Password screen, click on
[No].

6.

In the How to Contact Elixir screen, click on
[Print] and take the printout to the pc
connected to the internet.
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7.

Access
the
Elixir
Web
site
at
http:\\www.elixir.com. and click on [Product
Registration].

8.

In the Customer Information screen, enter
your Customer Number and Password, then
click on [Submit Form].

9.

In the Elixir Customer Menu,
[Download a New License File].

click

on

10. In the next Customer Information screen,
enter your PC Number and Machine Serial
Number, then click on [Submit Form].
11. In the Elixir Technologies screen, click on
[Click here to download your password].
12. Save the password.epw file to diskette and
copy it to your Elixir PC in the \ELIXIR
directory.
The application installation process will begin, see the
"Installation" section.
Contacting Elixir (no internet connection)
If you have no internet access at your site you must
contact Elixir and provide the serial number of the pc
where you will install the Elixir software. Elixir will provide a registration file (password.epw) that you must
copy to the Elixir pc.
Copy the password.epw file to \Elixir and start the
installation.
Select [Prepare my initial product license registration.
This workstation is not connected to the Internet] from
the Registration Option menu, then click on [Next].
The application installation process will begin, see the
"Installation" section.
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Soft key customers running Windows for Workgroups 3.1 or 3.11
Since Windows 3.1/3.11 does not have internet capability, you must contact Elixir to obtain your password
file. After installation of Elixir software, the installation
program verifies that the operating system is 3.1 or
3.11, runs passwd16.exe, and provides your machine
serial number.
To complete registration:
1.

Enter your customer number, password and
PC number, then print out a copy of this
screen.

2.

Fax, email, or mail Elixir the display printout.
Elixir will generate a password.epw file and
send it to you on diskette.

3.

Load the password.epw file in the \ELIXIR
directory.

The application installation process will begin, see the
"Installation" section.

Installation
This section describes how to install Elixir software
using the [Full] and [Custom] options. Installing additional Elixir applications to an existing version is also
explained.
Note: The software registration process must be completed (See the "Product Registration" section).
For information about starting Elixir applications after
installation, refer to the "Introduction" chapter.
During installation, the log file, XWIN.log, is created in
the drive:\Elixir directory. XWIN.log contains a list of
all directories and files copied or created, including information pertinent to the installation. It can be accessed, using Notepad or Wordpad.
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If you have any problems running Elixir software after
installation, refer to the "Troubleshooting" section of
the Elixir Getting Started Guide for more information.
Installing Elixir applications
Elixir provides a simple, interactive procedure for installing Elixir applications.
During installation you can select [Full] or [Custom]
installation.
Selecting a [Full] installs all Elixir applications and
demonstration files on the same drive. If you
have a previous version of Elixir software, this option overwrites the existing version.
Selecting a [Custom] installation allows you to
choose the Elixir applications and options (such
as Elixir demonstration files) you want installed,
as well as where you want certain options installed. For example, You may want the PDF
documentation in a different directory than the application.
You can also install Elixir program files (required
to run Elixir), and data files (files that you create
or files such as the Elixir demonstration files), in
separate drives and directories.
Full installation
To begin installation:
You can quit installation at any time, by pressing the
<Esc> key.
1.

Close all active applications.

2.

Insert the CD in your CD-ROM drive.

3.

In the "Welcome" screen, click on [Next].
The Release Notes? screen displays.
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4.

Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.
The Product Selection screen displays.

5.

Select the applications you want to install and
click on [Next].
The Selected Products screen displays.

6.

Verify the listed applications and click on
[Next]. If you need to delete or add to the list,
click on [Back] and reselect.

7.

Verify your user information and click on
[Next].

8.

In the Select Install Type screen, select [Full]
and click on [Next].

9.

Select the drive on which you want Elixir
software installed, then click on [Next].

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next].
11. In the Backup Replaced Files screen, click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].
12. In the Start Copying Files screen, click on
[Install].
Installation begins.
13. Once installation is complete, click on [Exit
Installer].
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Custom installation
To begin installation:
You can quit installation at any time, by pressing the
<Esc> key.
1.

Close all active applications.

2.

Insert the CD in your CD-ROM drive.

3.

In the "Welcome" screen, click on [Next].
The Release Notes? screen displays.

4.

Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.
The Product Selection screen displays.

5.

Select the applications you want to install and
click on [Next].
The Selected Products screen displays.

6.

Verify the listed applications and click on
[Next]. If you need to delete or add to the list,
click on [Back] and reselect.

7.

Verify your user information and click on
[Next].

8.

In the Select Install Type screen, select
[Custom] and click on [Next].

9.

In the Configuration Only? screen:
Selecting [Yes] allows you to load Configuration, Program, and Data files into any resident directory.
Selecting [No] allows you to deselect options
you do not wish installed.
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10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next].
11. In the Backup Replaced Files screen, click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].
12. In the Start Copying Files screen, click on
[Install].
Installation begins.
13. Once installation is complete, click on [Exit
Installer].
Adding applications
If you did not install all of the Elixir options while performing the Custom installation procedure, you can do
so at any time by following the steps described in the
"Custom installation" section of this chapter.
Adding newly licensed applications
If you purchase additional Elixir products, Elixir will
update your password file. You can access the Product Registration program from your program group
and re-download your initial product registration password file to activate your new products.
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Desktop basics

This chapter describes the ElixiSys Desktop layout
and basic operation. For detailed information, see the
ElixiSys Desktop User Guide.

Overview
The ElixiSys Desktop is the Windows-based operating
environment for launching and using Elixir Suite for
Xerox products such as ElixiForm, ElixiFont and
ElixiGraphics.
Additionally, the Desktop has many productivityenhancing features, including those which enable you
to:
convert files to other formats
view files in associated applications using the
Desktop Viewer
access your entire DOS directory structure using
the User Files icon
run batch files or executables from Dispatcher
use the Desktop Viewer
link files to applications, thereby allowing you to
start an application and load a file in one step
define icons for DOS or Windows-based applications you want to launch from the Desktop, such
as word processors, desktop publishers and
spreadsheets.
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Desktop layout
The ElixiSys Desktop comprises two main display
areas:
the top of the Desktop displays the Menu bar and
Message area
the remaining Desktop area displays icons.
Menu bar

Message area

Figure 3-1. Desktop window
Menu Bar
The ElixiSys Desktop menu bar allows you to access
the following pull down menus:
File
System
Special
DOS
Window
Help
3-2
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You can pull down a menu in one of the following
ways:
click on the menu
press the <Alt> key along with the underlined letter in the menu.
The Message area displays information about the operation in process, including relevant warning and error messages.

Icons
Each Desktop icon represents an application, folder,
utility or PC device configured for your system. Generally, the name, shape and appearance of an icon indicates its purpose or the type of action you can
perform.
Elixir folder icons
The five icons displayed at the top left of the Desktop
represent specific DOS directories. You can access
directory files and convert them from one format to
another using these icons. See the “Elixir folder structure” section of this chapter for more information.
Forms folder
This folder represents the drive:\ELIXIR\FORMS directory containing Elixir, Input and Output form files.

Fonts folder
This folder represents the drive:\ELIXIR\FONTS directory containing Elixir, Input and Output font files.
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Graphics folder
This folder represents the drive:\ELIXIR\PICS directory containing Elixir, Input and Output graphics files.

Documents folder
This folder represents the drive:\ELIXIR\DOCS directory containing document files referencing the Elixirformat files for multi-page documents.
Note that Documents folder functionality for .VIPP or
.PDF files requires VIPP/PDF option products.
Jobs folder
This folder represents drive:\ELIXIR\ JOBS\XGFOUT
directory containing JDT (Job Descriptor Ticket) files
for transfer to an output VIPP printer.

Clipboard icon
Temporarily stores Elixir-format (.ELX) form files during job creation. You can copy an Elixir-format form to
the Clipboard using standard copying procedures,
then copy the form to a specific job when you need it.
User Files icon
Provides access to all DOS directories and files, and
links applications to files.

Application icons
Application icons display at the right of the Desktop
and represent Elixir applications. Depending on your
installation, one or more of the following icons display.
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ElixiForm icon
This icon represents the
HighLight Option or Plus
ElixiForm for HighLight
clears the Desktop and
Form application.

ElixiForm. If you have Elixir
installed, the icon represents
Color. Opening the icon
starts the appropriate Elixi-

ElixiFont icon
This icon represents the ElixiFont application. Opening the icon clears the Desktop and starts ElixiFont.

ElixiGraphics icon
This icon represents the ElixiGraphics application.
Opening the icon clears the Desktop and starts
ElixiGraphics.

ElixiDoc icon
This icon represents the ElixiDoc application. ElixiDoc
enables you to run all Elixir-format file conversion applications in stand-alone mode, directly from DOS.

ElixirScan icon
This icon represents the ElixirScan application. Opening the icon clears the Desktop and starts ElixirScan.
ElixirScan allows you to electronically regenerate your
existing (paper) forms using most commerciallyavailable scanners, and to edit, update and store the
forms on your PC.

ELIXIR GETTING STARTED GUIDE

3-5

DESKTOP BASICS

User Tools icon
This icon represents User Tools, which contains tools
for creating icons for DOS and Windows applications
and batch files, launching the Elixir Website and editing HighLight full-color palettes.

Diskette icon
This icon enables you to access and format a diskette
in your PC diskette drive.

Tape icon
This icon enables you to access a tape drive connected to your PC.
Supported tape drive units include any 9-track, 1600
BPI tape device using an Overland TX-8 controller
card, such as the Qualstar 1052 or Qualstar 1260.
Printers icon
This icon enables you to access a local proof printer
connected to your PC.

Scanners icon
This icon enables you to start a scanner connected to
your PC directly from the Desktop.
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Dispatcher icon
This icon enables you to invoke DOS commands or
batch files into which you can embed replaceable parameters.

Converter icon
This icon enables you to convert font, form, graphics
and multi-page document files to different formats by
using simple “drag-and-drop” mouse operations.

Trashbin icon
This icon enables you to delete unwanted files.

Viewer icon
This icon enables you to view Elixir-format print or
screen files (.LP3 or .LW8 extensions), .DAT files,
Elixir forms, text and object files without having to
launch the Elixir applications.
Transformer icon
This icon enables you to apply utilities to Xerox-format
files that generally modify the file headers.
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Using the Desktop
The remaining sections of this chapter describe the
following basic Desktop operations:
accessing DOS
managing files
converting files.

Accessing DOS
The DOS pull-down menu allows you to run DOS
commands from the Desktop.
Selecting the [DOS Command] option or pressing
<Ctrl> + <D> displays a dialog box that allows you to
enter any standard DOS command. Enter a DOS
command and select [OK] to clear the Desktop and
execute the command from the following directory:
from the root (drive:\) directory, if there are no
windows open on the Desktop
from the directory corresponding to the window, if
a window is open on the Desktop.
After the DOS command executes, enter any key to
redisplay the Desktop.

Managing files
The following sections describe basic Desktop operations that are common to all Elixir products. These operations include the following basic file management
activities:
selecting files
dragging and dropping files
deleting files and folders
renaming files
duplicating files
overwriting existing files.
3-8

ELIXIR GETTING STARTED GUIDE

DESKTOP BASICS

Selecting files in an Elixir window
Files display as icons in Elixir windows. To display
files, double-click on an Elixir folder and then doubleclick on the appropriate Elixir, Input or Output folder.
If you double-click on an Input or Output folder, a window with more folders (representing different file formats) displays. Double-click on the appropriate folder
to display its files in a window. To select one file, click
on it. Note that the selected file is highlighted.
To select more than one file (or multi-select files),
click on a file, then <Shift>click on other files. The following figure shows several files selected.

Figure 3-2. Selecting files
To deselect a file, <Shift>click on it.
To select a range of files, click on the first file in the
range, then <Alt> click on the last file. The two files
and all displayed files between them display as
highlighted.
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To select all files in a directory, press <Ctrl> + <A>.
Alternatively, pull down the Selection menu and click
on [Select All].
To deselect all files, press <Ctrl> + <A>. Alternatively,
pull down the Selection menu and select [Unselect
All]. Clicking anywhere in the window other than on a
file also deselects selected files.
Press a character to select the first displayed file in
the window starting with the character. Press the
character again to select the next file, and so on.
File operations
With one or more files selected, you can perform file
operations by either dragging and dropping the files to
an icon, selecting an option from a pull-down menu or
entering a keyboard command.
Dragging files
To drag a selected file, click on it, hold down the
mouse button and move the mouse. A squareshaped dragging cursor displays in the window and
moves as you move the mouse. The following figure
shows a dragging cursor example.

Figure 3-3. Dragging
cursor example
To drag more than one file, first multi-select the files,
then click on any of the selected files while holding
down the left mouse button. If you select more than
one file, a double cursor displays, representing multiple files.
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Dropping files
To drop one or more files on a Desktop icon, select
the files and drag them to a position on top of the target icon, then release the mouse button.
If dropping the files on an icon is not permissible, an
X-cursor displays.

Figure 3-4. X-cursor
Deleting files and folders
To delete one or more files from a window, select the
files and perform one of the following actions:
drag and drop the files on the Trashbin icon
pull down the File menu and select [Delete]
press <Del> on your keyboard.
The Confirmation for Command dialog box displays with the
first selected file, as shown in the following figure.

Figure 3-5. Confirmation for Command
dialog box
The Confirmation for Command dialog box contains
the following options:
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Delete
Deletes the first file, then redisplays the Confirmation
for Command dialog box for subsequent files.
Skip
Does not delete the first file; redisplays the Confirmation for Command dialog box for the next file.
Confirm OFF and Continue
Deletes all selected files without further prompting.
You can modify your Desktop so that the Confirmation
for Command dialog box never displays when deleting
files, and files delete without prompting (see the ElixiSys Desktop User Guide for more information).
Deleting folders is similar to deleting files, except that
you can delete only empty folders.
Renaming files
To rename one or more files, select the file(s) and
perform one of the following actions:
press <F2>
click the right mouse button
pull down the File menu and select [Properties],
then type a new file name and extension in the
displayed dialog box.
Note that these actions change the external (DOS)
name of the file only.
The File Properties dialog box shown in the following
figure displays with the first selected file name.
The only option you can change is the file name and
extension.
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Figure 3-6. Renaming a file
See the “Overwriting existing files” section in this
chapter for more information.
Duplicating files
You can duplicate a file by copying it to the same
folder and renaming it. You can duplicate one or
more files in a single operation by first selecting the
file(s) you want to duplicate, then pulling-down the File
menu and selecting [Duplicate].
The Object Duplication dialog box displays with the
first selected file name, as shown in the following figure.

Figure 3-7. Object Duplication dialog box
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Follow these steps:
1.

In the [into] option, enter the new file name
and extension for the first file you want to
duplicate.

2.

Either select [Skip] to not copy the first file or
select [Duplicate] to copy the file to the new
file name.
The dialog box redisplays showing the next file
from the selected list.

Note that if you duplicate a file in any Elixir folder and
do not specify an extension for the [into] option, the
program uses an extension appropriate for that folder.
See the “Overwriting existing files” section in this
chapter for more information.
Overwriting existing files
If you copy or duplicate files using names that already
exist in the target directory, a Confirmation for Command dialog box displays, as shown in the following
figure. The dialog box shows the name of the existing
file for the first duplicate file selected.
When you rename a file with a name that already exists in the target directory, a warning message displays to inform you of same.

Figure 3-8. Confirmation for Command
dialog box
The Confirmation for Command dialog box contains
the following options:
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Overwrite
Overwrites the file, then redisplays the Confirmation
for Command dialog box with the next existing file in
the list.
Skip
Does not overwrite the existing file, then redisplays
the Confirmation for Command dialog box with the
name of the next existing file in the list.
Confirm OFF and Continue
Overwrites existing files in the target folder without further prompting.
You can modify your Desktop so that the Confirmation
for Command dialog box never displays and existing
files get overwritten without prompting (see the ElixiSys Desktop User Guide for more information).

Converting files
Using the Forms, Fonts, Graphics and Documents
folders and the Converter icon in the ElixiSys Desktop,
you can convert form, font, graphic and document
files between Xerox-, Elixir-, and other formats. You
can edit Elixir-format files in the appropriate Elixir application (ElixiForm, ElixiGraphics or ElixiFont), then
reconvert them to their original or another format using the Converter icon.
Before performing conversion operations, you should
familiarize yourself with the Elixir folder structure.
Elixir folder structure
The structure of each of the five Elixir folder icons is
similar, as described in this section.
Each Elixir folder icon contains three subordinate folders labeled Elixir, Input and Output.
For example, when you open the Forms Folder icon
(by double-clicking on it), the following window displays showing subordinate Elixir Forms, Input Forms
and Output Forms folders.
ELIXIR GETTING STARTED GUIDE
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Figure 3-9. Forms Folders window
Similarly, opening the other Elixir folder icons displays
a window showing subordinate folders called Elixir, Input and Output.
This folder structure allows you to view and edit form,
font, graphic, document and job files having different
formats, as shown in the following figure.

Figure 3-10. Input, Elixir, and Output folders
Each Input folder is similar to an "in basket" containing files you can convert to Elixir format by
copying them to the Converter icon. See the "File
conversions" section of this chapter for more
information.
Each Elixir folder is similar to a "working area"
where you can view and edit Elixir-format files.
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Each Output folder is similar to an "out basket" to
which edited Elixir-format files write after you
have copied them to the Converter icon. See the
"File conversions" section of this chapter for more
information.
To use Elixir folders for file editing, follow these steps:
1.

Copy the file you want to edit to the
appropriate Elixir folder.
The Elixir Folder opens to display the Elixir, Input
and Output sub-folders inside.

2.

Click on the Input folder.
The Input folder opens to display subfolders for
different file formats.

3.

Click on the folder corresponding to the
format of the file you are copying.

4.

Convert the file to Elixir format as described
in the "File conversions" section of this
chapter.

5.

Double-click on the converted Elixir-format
file to start the appropriate Elixir application
(such as ElixiGraphics or ElixiFont) and load
the file.

6.

Edit the file using the tools provided by the
Elixir application. After editing, save the file.

7.

Convert the edited Elixir-format file to the
format you want.
The converted file writes to the appropriate Output folder.

8.

Open the Output folder and copy
converted file to the desired location.
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File conversions
The simplest way to convert files is to use the Desktop
Converter icon. The following example demonstrates
how to convert an Elixir form file to another format.
Note that procedures for converting font, graphic and
document files are basically the same.
1.

Double-click on the Elixir Forms folder icon to
display the Forms Folders window.

2.

Click on either the Elixir, Input or Output
Forms folder to display a window with folders
representing different form format files.

3.

Double-click on the appropriate folder to
display the file(s) you want to convert.

4.

Select the file(s) you want to convert.

5.

Copy the file(s) by dragging and dropping
them on the Converter icon.

6.

In the dialog box(es) that display, specify the
output format(s) to which you want the file(s)
converted.
One or more output files with the correct file extensions will generate and automatically write to
appropriate Output folders.
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ElixiForm basics

This chapter describes ElixiForm and basic ElixiForm
operations. For information on additional ElixiForm
operations see the ElixiForm User Guide.

Overview
ElixiForm is an interactive forms design tool that allows you to create and edit forms in WYSIWYG (What
You See Is What You Get) mode.
A form created with ElixiForm is the static (or boiler
plate) component of a form, and contains elements
such as lines, boxes, text, and images.
You can then merge the static form with variable data
for printing on Xerox production or distributed printers.
The static data adds meaning to the variable data with
which it merges. For example, the following variable
data from a credit application form:
X
X

123-456-789
985-234-980

9876.23
11813.34

is more meaningful when merged with static data and
viewed together:
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Previously, creating and editing static forms for printing on Xerox production or distributed printers was the
responsibility of applications personnel working on
mainframe computers, who defined form elements using Forms Source Language (FSL), a language that
describes the location of line, box, text, and image
elements, as well as page size and layout.
Limitations to this approach are:
Defining and revising an FSL form is complicated
and time-consuming.
Changes to the form are not apparent when adding FSL statements.
You must compile and proof-print the completed
FSL file on the high-speed printer.
With ElixiForm, you can see each static form element
as you add or revise it. With an optional desktop
proof-printer you can generate proofs at your desk,
then using the Converter in the ElixiSys Desktop, you
can compile your forms on your PC, thus freeing your
Xerox printer from these tasks.
You can also use the ElixiSys Desktop to define a
multi-page document (.DAT file) containing a group of
forms created in ElixiForm. You can then convert this
multi-page document to other formats using the ElixiSys Desktop.
Depending on the ElixiForm product you have installed, your screens and options may differ from the
figures displayed in this chapter.

4-2

ELIXIR GETTING STARTED GUIDE

ELIXIFORM BASICS

ElixiForm layout
The ElixiForm window contains the following features:
a Work area at the center of the screen
a Work Area menu bar above the work area
an ElixiForm menu bar at the top of the screen
a Message area between the menu bars
a Toolbox to the left of the screen
a Toolbar above the work area.
Close button
Toolbox

Work area
Toolbar

Message
area

Work area
menu bar

ElixiForm
menu bar

Main Work area

Menu bars
ElixiForm provides a menu and sub-menu system to
access ElixiForm options. To display a pull-down
menu, click on the menu button or press the <Alt> key
along with the underlined letter in the menu, and select an option from the list that displays.
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From the ElixiForm menu bar you can access the following pull-down menus:
File
System
Window
Help
From the Work Area menu bar you can access the
following pull-down menus:
Edit
Tools
View
Options
Toolbox <F10>
The Toolbox displays to the left of the Work area and
provides tools for creating and editing the elements
that make up a form. If you maximize the work area,
the Toolbox displays on top of the work area.
You can toggle between hiding and showing the Toolbox by either clicking on the Toolbox icon in the Toolbar, pulling down the Window menu and selecting
[Tools], or by pressing <F10>.
When you select a tool, the options for that tool display in the Toolbox with a short description of the tool
in the message panel. You can choose options for
that tool by clicking on the options.
The preview panel displays your option selection. If
you select a box with a fill, the preview panel also displays the name of the fill.
Toolbar
The Toolbar displays across the top of the work area
and contains the digital ruler, selected element, start
coordinates, width and depth. The options in the
Toolbar allow you to set up user preferences, undo
and redo operations, run the spell checker, and show
or hide the Toolbox.
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Message area
When you position the cursor over an icon in the Toolbox or Toolbar a description of the icon displays in the
Message area. Operational messages also display in
this area.

Creating a form
This section guides you through the basics of creating, editing, saving, printing and retrieving a simple
form, such as the sample FedBank Credit Application.
The sample FedBank credit application is installed
with ElixiForm as a demonstration file. If you did not
install the Elixir demonstration files, and you want to
view this sample form, you can install it now by performing a [Custom] installation. See the "Installation"
chapter for more information.
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Loading a new form
To create your form, start ElixiForm (see the "Introduction" chapter) and then load a new form.
To load a new form:
1.

Pull down the File menu and select [New
Form].
The Page Properties dialog box displays.

2.

Select the page property options for your
form.
See the ElixiForm User Guide for more information about options in this dialog box.

4-6

ELIXIR GETTING STARTED GUIDE

ELIXIFORM BASICS

3.

Click on [OK].
The Page Databasing dialog box displays.

4.

Enter information for the new form (optional).
See the ElixiForm User Guide for more information about options in this dialog box.

5.

Click on [OK].

A new, untitled form displays in the work area.
Using the grid, rulers and long crosshair
Display the grid, rulers, and long crosshair to help with
placing elements accurately on your form.
To display the grid, click on the top half of the Grid
icon in the Toolbar.
To display the graphical ruler at the top and left edges
of the Work area, click on the Graphical Ruler icon in
the Toolbar.
To display the long crosshair, click on the Long Crosshair icon in the Toolbar.
You can also select the above options by pulling down
the View menu and selecting the applicable option.
The digital ruler displays at the top left of the Toolbar
and shows the horizontal and vertical position of the
screen pointer.
Adding form elements
The following section describes how to create elements such as lines, boxes, text, and images, that
make up a form.

ELIXIR GETTING STARTED GUIDE

4-7

ELIXIFORM BASICS

Drawing lines
To draw a line:
1.

Select the Line tool to display the Line
toolbox.

2.

Select line properties from the options that
display in the Line toolbox.
Options include line direction, width, style, and
color.

3.

Position the screen pointer in the work area
where you want the line to begin and press
and hold the left mouse button.

4.

Drag the screen pointer across the work area.
A line displays.

5.

Release the mouse button to end the line.

Drawing boxes
To draw a box:
1.

Select the Box tool to display the Box toolbox.

2.

Select the box properties from the options
that display.
Options include box positioning, shape, border
width and style, number of box splits, border
color, and shading.

3.

Position the screen pointer where you want
the box to start.
You can use the rulers to judge the margins.

4.

4-8

Drag the screen pointer down and toward the
right of the screen.
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As you move the screen pointer, the box increases in size. Continue moving the screen
pointer and watching the rulers until you have created the box size you want.
5.

Release the left mouse button to place the
box.
The box outline becomes solid.

Continue adding boxes to your form by repeating the
above procedure.
Adding text
To add text to your form
1.

Select the Text icon to display the Text
toolbox.

2.

Select text properties from the options that
display.
Options include character and word spacing,
boundaries, justification, positioning, color, lines
per inch, columns and font type.

3.

Select a font from the font list in the Toolbox.
The default font is the font at the top of the list.

4.

Click in the work area where you want to
begin entering text.

5.

Enter characters from the keyboard.

6.

Right-click to finish entering text for that text
block.
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Adding images
To add an image to your form:
1.

Select the Image tool to display the Image
toolbox.

2.

Click on the [Load Image] option in the
Toolbox.
The Load Image dialog box displays images in
the drive:\ELIXIR\PICS\PRINTER directory.

3.

Select an .LP3 image and click on [OK].
(You can select FBLOGO.LP3 to display the FedBank logo used in the FedBank sample credit application described at the beginning of this
section.)
To
use
an
.LW8
image
in
drive:\ELIXIR\PICS\SCREEN directory, select
[.LW8] from the window at the bottom of the dialog box. Note that .LW8 images are used for display purposes only and cannot be used for
conversions or printing.

4.

Press and hold the left mouse button.
The image attaches to the screen pointer.

5.

Position the image on the form and release
the left mouse button to fix it in place.

Undo/redo feature
ElixiForm allows you to undo or redo an operation.
To cancel the most recent operation:
Click on the Undo icon in the Toolbar or pull down
the Edit menu and select [Undo]. If you want to
cancel a group operation, ElixiForm undoes the
operation one element at a time.
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To cancel the most recent [Undo] operation:
Click on the Redo icon in the Toolbar or pull down
the Edit menu and select [Redo].

Modifying a form
ElixiForm allows you to modify a form by editing individual elements as often as necessary. This includes
moving, copying and deleting elements, and changing
element properties.
To move, copy, or delete an element,
1.

Select the Select/Edit tool to display the
Select/Edit toolbox.

2.

Click on the element with the left mouse
button.

3.

Copy, delete or move the selected element as
follows:
To copy a selected element, select the [Copy]
option and the number of copies you want to
make, then drag the selected element in the
direction you want the duplicate element to
display.
To delete a selected element, select the [Delete] option.
To move a selected element, drag it to a new
position in the Work area.

To change the properties of an element:
1.

Select the Select/Edit tool to display the
Select/Edit toolbox

2.

Click on the element with the right mouse
button.
The Toolbox for that element displays.
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3.

Select the applicable option(s) in the Toolbox.

The procedures for editing are similar for lines, boxes,
images or text and are described in detail in the appropriate chapters in the ElixiForm User Guide.

Saving a form <Ctrl> + <S>
You may want to periodically save your work as you
are designing a form, and when you finish it.
To save a form:
1.

Pull down the File menu and select [Save
Form] or press <Ctrl> + <S>.

The Save Form dialog box displays.
2.

Enter a name in the file name box. You do not
need to type an extension.
If you plan to convert your form to other formats
you should save the form with a maximum sixletter file name. Longer file names are truncated
upon conversion and could result in overwriting
existing files.

3.

Click on [OK].

Once you have saved a form, use <Ctrl> + <S> to
quick save your work.
To save an existing form with a new name:
1.

Pull down the File menu and select [Save
Form As] or press <F7>.
The Save Form As dialog box displays.

2.

Enter a new file name.

3.

Click on [OK].
The form is saved with a new name and the original form exists with the original name.
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Proof-printing a form
To proof-print your form, pull down the File menu and
select [Print].
Select your proof printer and any other print options
from the Print dialog box and click on [OK]. Your form
prints on the selected printer.
See the ElixiForm User Guide for more detailed
information.

Retrieving a saved form
To retrieve a previously saved form:
1.

Pull down the File menu and select [Load
Form].
The Load Form dialog box displays.

2.

Select the name of the form you want to load.

3.

Click on [OK].
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ElixiFont basics

This chapter describes ElixiFont and basic ElixiFont
operations. For information on additional ElixiFont operations see the ElixiFont User Guide.

Overview
This section describes ElixiFont, a sophisticated
Windows-based bitmap font editor that allows you to
create and edit fonts in WYSIWYG (What You See Is
What You Get) format.
ElixiFont allows you to perform the following font
operations:
edit individual characters in a font using tools to
manipulate the character bitmap
apply transformations, such as embolden, italicize, and underline, to one, all, or a sequence of
characters in a font
display and change character or font properties
such as kerning, baseline offset, and orientation.
For fonts converted from Xerox format, ElixiFont also
allows you to display and change Xerox header
information.
With the ElixiSys Desktop, you can import fonts and
convert them to Elixir format. You can then display
and edit these fonts on your PC, and convert them
back to an output format.
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Font basics
This section describes Elixir font characteristics, and
the procedures used to display, edit, and apply metrics to the fonts. The following figure shows some important characteristics of a character in a cell.

Above
baseline
Cell
Height

Blanks
Right

Blanks
Left

Below
baseline

Baseline
Offset

Cell width

Figure 5-1. Character and cell components
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The following figure shows some character and line
spacing attributes on a printed page.

Above
baseline

Linespacing

Below
baseline
Leading

Figure 5-2. Line spacing components
ElixiForm uses the following formula for calculating
line spacing in Elixir fonts:
Line spacing = above baseline + below baseline + leading

ElixiFont layout
The ElixiFont window contains the following features:
a Work area at the center of the screen
a Work Area menu bar above the work area
an ElixiFont menu bar at the top of the screen
a Message area between the menu bars
a Toolbox to the left of the screen.
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Close button
Toolbox

Message
area

Work area
menu bar

ElixiFont
menu bar

Work area

Figure 5-3. ElixiFont window
Menu bars
ElixiFont provides a menu and sub-menu system to
access ElixiFont options. To display a pull-down
menu, click on the menu button or press the <Alt> key
along with the underlined letter in the menu and select
an option from the list that displays.
The ElixiFont menu bar allows you to access the following pull-down menus:
File
System
Window
Help
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The Work area menu bar allows you to access the following pull-down menus:
Font
Edit
Char
Transforms
Toolbox <F10>
The Toolbox displays to the left of the work area and
provides tools for viewing, editing and transforming
characters and fonts. If you maximize the work area,
the Toolbox displays on top of the work area.
You can toggle between hiding and showing the Toolbox by pulling down the Window menu and selecting
[Tools] or by pressing <F10>.
When you select a tool, the options for that tool display in the Toolbox with a short description of the tool
in the message panel. You can choose options for
that tool by selecting the option icons.
You can also use the [Undo] button to undo the last
operation, the [Stop] button to stop the current conversion, or the [Go] button apply the current tool or
transformation.
Message area
When you position the cursor over an icon in the Toolbox, a description of the icon displays in the Message
area. Operational messages and characteristics of a
loaded font also display in this area.
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Using ElixiFont
This section describes basic ElixiFont operations including:
loading an existing font
editing a font
transforming a font
creating a font
saving a font.
Loading an existing font
To load an Elixir font:
1.

Start ElixiFont as described in the
"Introduction" chapter, pull down the File
menu, and select [Open Font] or press <F8>.
The Load Font dialog box displays.
The list of Elixir fonts in the default directory,
drive:\ELIXIR\FONTS\ELIXIR, display with .HDR
extensions.

2.

Select a font and click on [OK].
You can also double-click on the font name.
The ElixiFont main screen displays the font as
shown in the following figure.
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Figure 5-4. Loaded font
The character bitmaps of the font, arranged leftto-right and top-to-bottom by ASCII position of the
character in the font, display in the Work area.
Note that the font header .HDR file defines the
ASCII positions.
Use the <Page Up>, <Page Down>, <Home>,
and <End> keys, or the scroll buttons to scroll
through the entire font as necessary.
When you move the screen pointer on a character, a dark box displays around it. This is the current character.
The ASCII, decimal and
hexadecimal values of the current character display in the message area.
The width of the current character (in dots), and
the character type (NULL, SPACING, or NONBLANK) also display.
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A null character indicates that there is no
character defined for this position and displays as a filled gray cell (like the first 32
characters in the displayed font).
A spacing character occupies a cell but does
not have a bitmap and prints as a blank
space.
All other characters are non-blank and contain bitmaps.

Editing a font
To edit a character in a font, select the character you
want to edit then click on the Edit tool in the Toolbox.
You can also double-click on a character.
The Edit Window displays.
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Edit tool

Edit Window Menu Bar

Edit Window Toolbar

Bitmap window

Framing window

Figure 5-5. Edit window
Edit Window
The Edit Window contains the following:
Edit Window Toolbar
This Toolbar contains the following icons:
Pointer/Mouse Coordinates:
Displays the current pointer position in X (horizontal) and Y (vertical) coordinates.
Drawing Start Coordinates:
Displays the starting horizontal and vertical coordinates for the current drawing operation.

ELIXIR GETTING STARTED GUIDE

5-9

ELIXIFONT BASICS

Drawing Size:
When the corresponding option is selected, displays the current ruler length, copy/move area
width and height, line length, box width and
height, or circle radius.
Grid:
Displays/hides the grid (toggle). The grid does
not display for magnifications of 4x and less.
Undo:
Undoes the last edit operation.
Down Arrow:
Decreases the magnification.
Magnification:
Shows the current magnification.
Up Arrow:
Increases the magnification.
Post:
Saves changes made to the character bitmap.
Prev:
Displays the previous character in the font for editing. Prompts for confirmation if you made
changes to the current character.
Next:
Displays the next character in the font for editing.
Prompts for confirmation if you made changes to
the current character.
Characters in the font
The bottom of the window shows a partial list of characters with the current character selected.
You can click on another character to display it in the
Edit Window. You can also scroll through the entire
font using the <Page Up>, <Page Down>, <Home>
and <End> keys or you can use the scroll buttons.
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Character bitmap
The left side of the window displays a bitmap of the
character shown initially at 8x magnification. Each dot
in the bitmap displays as a black or white box 8 bits
high and 8 bits wide.
Framing window
The right of the window contains the framing window
that you can move to display different portions of the
character you are editing.
Editing tools
Edit the characters using the editing tools available in
the Edit toolbox or the pull-down menus in the Edit
Window menu bar.
To use an editing tool:
1.

Select a tool or pull down the Tools menu and
select an option.
Select [Character Properties] to display a dialog box from which you can enter properties
for a character.
Select [Ruler] to display the digital ruler in the
Edit Window Toolbar.
Select [Copy/Move] to select a rectangular
area of the displayed character and move or
copy it to another location in the cell by selecting the [Move] or [Copy] options in the
Toolbox.
Select a drawing tool to use that tool to edit
the bitmap by clicking and dragging the
mouse in the bitmap window.
Select [Blend] to blend another character into
the current cell. After selecting [Blend], click
on another character in the font to blend it
with the currently loaded character in the
framing window on the right. After positioning
it, click on [Accept] at the bottom of the Toolbox to blend the character with the loaded
character.
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2.

Select from any additional options that may
display in the Toolbox.

3.

Click on the [Post] button in the Toolbar, or
pull down the Char menu and select [Post], to
post and save your changes.

Transforming a font
You can apply transformation operations to a single
character or to the entire font. Select the Transformation tool to display transformation operations and options in the Toolbox.
To apply a transformation:
1.

Load a font and select a character or the
entire font.
To select an entire font, pull down the Edit menu
and select [Select All]. To deselect a font, pull
down the Edit menu and select [Unselect All].

2.

Select the transformation tool.
The Transformation toolbox displays the transformation operations.

3.

Select a transformation operation from the
Toolbox.
In the previous figure, the [Rotate] operation is
selected.

4.

Select any options from the Toolbox.
Note that the options in the Toolbox change depending on the transformation tool you select. In
the previous figure, the [Clockwise] option is selected.
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5.

Click on the [Go] button to apply the
transformation.
For example, if you perform the Rotate operation
shown in the previous figure, the character or entire font rotates 90° to the right. Repeatedly clicking on the [Go] button rotates the character(s) in
90° increments.

a
Figure 5-6. Clockwise rotation example
6.

Click on the [Stop] button
transformation in progress.

to

stop

a

7.

Click on the [Undo] button to undo a
transformation operation.
Note that if you have stopped the current operation, the [Undo] option may not be available.

Creating a font
To create an Elixir font you can either modify an existing Elixir font and save it to a new file or you can create a new font using the [New Font] option in the Font
menu.
To create a new font using the [New Font] option:
1.

Pull down the Font menu and select [New
Font].
The Properties of New Font dialog box displays.

2.

Enter a file name and character properties for
the new font.
See the ElixiFont User Guide for detailed information about the options in the Properties of New
Font dialog box.

3.

Click on [OK].
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The Font Properties dialog box displays.
4.

Enter additional properties for the new font.
See the ElixiFont User Guide for detailed information about the options in the Font Properties dialog box.

5.

Click on [OK].
Blank cells representing the characters in your
font display. The font name you specified displays at the top left corner of the window.

6.

Double-click on a blank cell to display it in the
Edit window.

7.

Use the Edit tools to create a customized
character in the cell.

8.

Pull down the Char menu and select [Post] to
save the newly created character.
You can now transform the character using any of
the transformation operations.

Saving a font
To save a font to the current file, pull down the File
menu and select [Save] or press <Ctrl> + <S>. The
font is saved to the drive:\ELIXIR\FONTS\ELIXIR directory with a .HDR extension.
To save a font to a new file, pull down the File menu,
select [Save Font As], type a new file name in the
Save Font As dialog box and click on [OK]. Your file
is saved in the drive:\ELIXIR\FONTS\ELIXIR directory
with the new name and a .HDR extension.
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ElixiGraphics basics

This chapter describes ElixiGraphics and basic ElixiGraphics operations. For information on additional
ElixiGraphics operations see the ElixiGraphics User
Guide.

Overview
ElixiGraphics is a Windows-based, bitmap editor that
allows you to create and edit Elixir-format graphics.
Depending on the tool set you have selected in the
ElixiSys Desktop and the ElixiKey(s) you have connected to your PC, ElixiGraphics allows you to edit or
create black-and-white, highlight color or full-color
Elixir-format graphics.
ElixiGraphics provides the environment and drawing
tools normally found on dedicated graphics workstations. Combined with the ElixiSys Desktop, ElixiGraphics provides powerful features to support your
Xerox high-speed laser printing systems.
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ElixiGraphics layout
The ElixiGraphics window contains the following
features:
a Work area at the center of the screen
a Work Area menu bar above the work area
an ElixiGraphics menu bar at the top of the
screen
a Message area between the menu bars
a Toolbox to the left of the screen
a Toolbar above the work area.
Close button
Toolbox

Toolbar

Message
area

Work Area
menu bar

ElixiGraphics
menu bar

Work area

Figure 6-1. ElixiGraphics window
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Menu bars
ElixiGraphics provides a menu and sub-menu system
to access ElixiGraphics options. To display a pulldown menu, click on the menu button or press the
<Alt> key along with the underlined letter in the menu
and select an option from the list that displays.
The ElixiGraphics menu bar allows you to access the
following pull-down menus:
System
Window
Help
The Work Area menu bar allows you to access the
following pull-down menus:
File
Edit
Image
Tool
Transform
Toolbox <F10>
The Toolbox displays to the left of the work area and
provides drawing tools and transformation tools for
editing and creating an image. If you maximize the
work area, the Toolbox displays on top of the work
area.
You can toggle between hiding and showing the Toolbox by pulling down the Window menu and selecting
[Tools] or by pressing <F10>.
When you select a tool, the options for that tool display in the Toolbox with a short description of the tool
in the message area. You can choose options for that
tool by selecting the option icons.
The Preview panel displays your option selections.
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Toolbar
The Toolbar displays across the top of the work area
and contains the digital ruler, current-object coordinates, and icons for magnifying and reducing an image, undoing and redoing editing operations, changing
the drawing mode, and selecting the grid.
Message area
When you position the cursor over an icon in the Toolbox, a description of the icon displays in the Message
area. The color mode of the loaded image and operational messages also display in this area.

Using ElixiGraphics
This section describes basic ElixiGraphics operations
including:
loading an existing image
creating a new image
using the drawing tools
using the transform tools
resetting an image
saving an image
proof-printing an image.
Loading an existing image
With the ElixiGraphics main screen displayed, you can
load an image as follows:
1.

Pull down the File menu and select [Load] or
press <F8>.
The Load Image dialog box displays with an alphabetical list of all available images.
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If you chose to install them, the names of demonstration files are listed. These images are Elixirformat files in drive:\ELIXIR\PICS\PRINTER.
To display .BMP images, select [.BMP] from the
window at the bottom of the dialog box.
2.

Select an image file.
For example, select STARS.LP3, a demonstration file supplied with ElixiGraphics.
The image displays in the work area and the file
name displays in the Work Area menu bar. The
following figure shows the demonstration file
STARS.LP3 displayed.

Figure 6-2. Loaded file
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Creating an image
You can create an image by either modifying an existing Elixir-format image and saving it to a new file or by
using the [New] option in the File menu.
To create a new image using the [New] option:
1.

Pull down the File menu, and select [New] or
press <F9>.
The Image Attributes dialog box displays.

2.

Enter a file name and attributes for your
image.
See the ElixiGraphics User Guide for detailed information about the options in this dialog box.

3.

Click on [OK].
An image area displays in the work area and the
name of your image displays in the Work Area
menu bar.

Use the drawing and transformation tools to create
your image.
Using the drawing tools
You can create or edit an image using the drawing
tools. To use a drawing tool, select it from the Toolbox or from the Tool menu.
For example to use the Line tool, select the Line tool
in the Toolbox or pull down the Tool menu and select
[Line]. The Line toolbox displays the Line tool options.
Figure 6-3. Line toolbox
FG
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To set the color of the drawing tool, click on the [FG]
button until the color you want displays in the button.
If you are a full-color user, select a color from the
Choose Foreground Color dialog box that displays
when you click on the [FG] button.
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To set the color of the background, click on the [BG]
button until the color you want displays in the button.
If you are a full-color user, select a color from the
Choose Background Color dialog box that displays
when you click on the [BG] button.
To draw with a drawing tool, click and drag the mouse
in the Work area.
You can set properties for a drawing tool by selecting
the tool options. The options you select display in the
preview panel.

Using the transform tool
You can use the Transform tool to apply transformation operations to an image or image area. The following figure shows available transformation
operations.
To perform a transformation operation:
1.

Select the Transform tool.
The Transformation toolbox displays

2.

Select the area you want to transform by
dragging the mouse in the work area. (To
transform the whole area, skip this step.)
The selected area displays in a dashed box.

3.

Select a transformation operation from the
Toolbox or from the Transform menu.
In the previous figure, the Rotate operation is
selected.

4.

Select
applicable
transformation.

options

for

the

In the previous figure the [180 degrees] Rotate
option is selected.
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Note that the options in the Toolbox change, depending on the transformation tool you select.
5.

Click on the [Go] button to perform the
transformation operation.
The following figure shows an example of a [180
degrees] Rotate operation. Repeatedly clicking
on the [Go] button rotates the image or image
area in 180° increments.

Figure 6-4. Rotate example
Resetting an image
You can reset an image toclear all edits since the last
save operation. To reset an image, pull down the File
menu and select [Reset].
Saving an image
To save an image to the current file, pull down the
File menu and select [Save] or press <Ctrl> + <S>.
The image is saved to drive:\ELIXIR\PICS\PRINTER
directory with an .LP3 extension.
To save an image to a new file, pull down the File
menu and select [Save As] or press <F7>, and enter a
new file name in the Save Image dialog box. When
you click on [OK], the image is saved in the
drive:\ELIXIR\PICS\PRINTER directory with an .LP3
extension.
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Proof printing an image
To proof-print an image, pull down the File menu and
select [Print] or press <Ctrl> + <Shift> + <F10>.
Select your proof printer and other print options from
the Print dialog box. When you click on [OK], the image prints on the selected printer.
See the ElixiGraphics User Guide for detailed information about printing an image.
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A.

Troubleshooting

This appendix contains information about solving
common problems you might encounter when using
Elixir Suite for Xerox software. It includes information
about installation, protection keys, and problem solving for the ElixiSys Desktop, ElixiForm, ElixiGraphics,
and ElixiFont applications. It also lists all operational
and error messages issued by the Elixir Suite for
Xerox products.
For information about minimum and maximum parameters, please refer to the appropriate Elixir Suite
for Xerox product documentation.
If you encounter "out of memory", "disk full", or other
memory or disk errors, please refer to your Microsoft
Windows or MS-DOS documentation for further
information.

Notes and cautions
The following general note applies to the Elixir suite
for Xerox software.
Elixir software has been tested with HP Windows
printer drivers for proof printing. Other printer drivers
are not supported and may produce unpredictable results when used with Elixir software.
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Installation
This section contains general problem-solving information about first time installation and reinstallation of
Elixir Suite for Xerox software.
If you encounter a problem when installing Elixir
software, make sure that the appropriate ElixiKey
is connected to the LPT1 parallel port of your PC.
See chapter 1 "Introduction" for more information
about installation and ElixiKeys.
If you have any problems running your Elixir software after installation, ensure that you have the
right toolset selected for your Elixir software and
try running the software again. See the toolset table in chapter 1 "Introduction" for information regarding toolsets.
When installing Elixir Suite for Xerox software
over an existing Windows version, make sure that
the ElixiKeys connected to LPT1 are the same as
the ones connected for the previous installation.
If you are going to use one or more different keys
(for example, when adding an Elixir product to
your system), connect all the appropriate keys,
delete all program files from the drive:\ELIXIR directory, and reinstall the Elixir Suite for Xerox
product.

Software protection keys
This section provides information for using software
protection keys.
If you are using Sentinel Pro and SuperPro protection keys, make sure that the Sentinel Pro
keys are placed closest to the PC.
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If you are using more than one SuperPro protection key, place any SuperPro keys with a
xxxxx016xx lot number before any SuperPro keys
without the 16 series number.
If the parallel port on your PC uses a WinBond
83757 or 28375F I/O controller chip and you are
experiencing difficulties with the software protection keys, please call Elixir Technologies for
assistance.

ElixiSys Desktop
This section contains information for solving common
problems occurring while using the ElixiSys Desktop.
After installing another software package, Elixir
software operates erratically
The existence of a BWCC.DLL file in a directory
other than the Windows \SYSTEM directory may
cause errors when performing operations such as
copying files to Elixir folders using the UserFiles
icon.
Elixir installs a BWCC.DLL file dated 1993 or later
in the Windows \SYSTEM directory during installation.
Other programs may also install
BWCC.DLL files in different directories. Delete
any other versions of the BWCC.DLL file from
your hard disk to prevent errors.
Keys are not being recognized due to a nonstandard parallel port address
Modify the Check_Key_Port parameter in the
ELIXIR\DESKTOP\SYSTEM\SYSTEM.INI
with
the appropriate address below:
Check_Key_Port=DEFAULT
Check_Key_Port=LPT1
Check_Key_Port=LPT2
Check_Key_Port=LPT3
Check_Key_Port=0x278
Check_Key_Port=0x378
Check_Key_Port=0x3BC
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Unless there is a problem with key-checking, the
DEFAULT option should be used.
Tape drive not responding
If your tape drive device is off-line when you attempt to access it, or if it does not respond when
it is on-line, a dialog box prompts you to cancel or
retry the tape copy operation. You may be required to click on [Cancel] more than once or to
bring the tape drive on-line to cancel the
operation.

Elixir supports the Overland Data TX8 controller
card and software. Currently, no Windows driver
for the card exists. Support for an alternate controller card and software will be provided in a future release.
If you have difficulty copying files to or from an installed tape drive from within the Read from Tape
Device or Write to Tape Device dialog boxes, first
ensure that your tape drive heads are clean and
free of debris. If you continue to experience problems, you should run Overland Data's XTEST utility (included with the tape drive software) to check
for any possible tape drive hardware or software
failures.
In addition to using the Tape icon, you can also
run the DSK2TAP or TAP2DSK stand-alone utilities to copy files to or from tape, respectively.
See chapter 2, "Installation" for information about
configuring your PC for a tape drive, and see the
ElixiSys Desktop User Guide for information
about the DSK2TAP and TAP2DSK utilities.
No default printer available
The ElixiSys Desktop uses the printer(s) or print
driver(s) you set up in your Windows environment. If you have not defined a default printer or
print driver in Windows, you cannot print from the
Desktop. Set up a default printer or print driver
using the Windows Print Manager and retry the
print operation.
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Copying files to a diskette that is full or becomes
full may cause your PC to hang
Before copying files to a diskette, make sure
there is enough space on the diskette to copy the
selected files.
Copying files to and from Xerox format diskette
fails
Xerox printers use a non-standard diskette format
which is different from DOS format. When accessing or copying files to or from Xerox 9700 format diskettes from within the System Diskette
dialog box, the ElixiDisk utilities must access the
diskette at a hardware level that Windows may
not allow. (The utilities must directly access the
real (BIOS) memory area, while Windows makes
only virtual memory available for these utilities).
Due to these restrictions, Elixir cannot guarantee
the results of Xerox 9700 diskette operations from
the Desktop. If you experience problems accessing or copying files to or from a Xerox 9700 format diskette, you can use the stand-alone
ElixiDisk utilities from the DOS command line.
Fonts do not print correctly when proof printing
using a Windows print driver
When proof printing multiple files, your printer
may run out of memory resulting in incorrect fonts
being used, or the printer may stop printing due to
memory overflow.
To clear this condition, turn the printer off and
then back on. All temporary fonts are cleared
from the printer font list. Reprint your files and
select the [Always] option for downloading fonts.
All Elixir fonts are removed from the printer font
list when you turn off the printer. The next time
you print, you can select the [Once] option to reinstall the required fonts on the printer.
Note that using the [Once] option to permanently
store fonts on your printer reduces available
printer memory and may not allow the printing of
large graphics or files.
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Use the Windows Print Manager to view the fonts
used by Windows. Permanent font names are
prefaced with an asterisk. When manually adding
or deleting fonts from the Windows font list, access the Windows font installer dialog box
through the Print Manager and not through the
Desktop Print dialog box [Setup] option.
See your Microsoft Windows documentation for
more information about the Print Manager.

ElixiForm
This section contains information about solving common problems you might encounter when using ElixiForm. Elixir form limits are based on 9700 printer
limitations. These limits may be lower than the limits
on other Xerox production printer
Graphics or drawing elements do not display
correctly
Install and use the Windows screen driver supplied with Windows, and select either the 256 or
16 color display.
Text on a form appears fuzzy
Text created in earlier versions of ElixiForm may
display fuzzy. Regenerate the screen fonts for
correct display.
Forms generated in ElixiForm version 3.0 or later
Due to changes in the Elixir internal format, forms
generated by version 3.0 or later can not be used
with previous versions of ElixiForm.
Cut/Copy/Paste options
Only internal text can be cut, copied, and pasted,
and only by using hot keys (keyboard shortcuts).
The Cut/Copy/Paste options in the Edit menu will
be implemented for all elements in a future
release.
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Characters in a font (in positions 16 through 31)
are not accessible from the keyboard or printable
on Xerox printers.
If you specify 16 as the start position of your font
when tiling a graphic into a font, you can access
characters 16 through to 31 from the keyboard by
pressing <Alt> + <0*>: where * is the start position of the character, or by using the Soft
Keyboard.
You can print characters 16 through 31 on an HP
printer, but you can not print them on a Xerox
printer because the 16 through 31 values are reserved for Xerox printer command characters.
GEM screen fonts
Screen fonts generated under the GEM environment may exhibit some quality loss in Windows
versions (version 3.0 or later) of ElixiForm. To
correct this, reconvert the screen fonts using the
Desktop and Converters.
Lines attached to the outside of a box do not line
up exactly with box splits
If you want attached lines to line up exactly with
box splits, either move the box to align with the
attached line or draw the box splits as lines extending outside the box.
Maximum patterns per form
The maximum number of patterns allowed per
form is 64.
Maximum inks per .FSL or .FRM
The maximum number of inks allowed per .FSL
or .FRM form is 64.
Maximum size graphics template
The maximum size for a graphics template depends on the memory currently available in
Windows.
Maximum text blocks per form
The maximum number of text blocks allowed on a
form is 32,000.
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Maximum graphics/logos per form
The maximum number of graphics or logos allowed on a form is 16.
Maximum fonts per form
Xerox printers have a limitation of 25 fonts per
form when printing. Actual printer memory may
reduce this number.
Mouse operations in Palette Editor
For correct mouse operation when using the Palette Editor, specify your mouse driver in your
AUTOEXEC.BAT file.
Screen retains residue of previous operations
Use the * key on the numeric keypad to refresh
your screen when residue is present.

ElixiGraphics
This section contains information about solving common problems you might encounter when using
ElixiGraphics.
Maximum file size for a graphic is exceeded
The maximum file size for a full-page highlight
color or other graphic depends how much memory is available for Windows (physical memory
and Windows swap file size).
Dotted or dashed border widths wider than one
dot
Some Windows drivers (including VGA) do not
support drawing objects (excluding lines) with dotted or dashed border widths wider than one dot.
A solid border displays regardless of your choice
of border style if your driver does not support
these ElixiGraphics features.
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Floodfilling a graphic (logo) with a highlight color
on a black-and-white monitor causes the logo to
display as a solid black box the next time you
open it in ElixiGraphics or when it is placed on a
form in ElixiForm.
To simulate color on a black-and-white monitor,
the monitor must support gray-scale.
Graphics or drawing elements do not display
correctly
Install and use the Windows screen driver supplied with Windows, and select either the 256 or
16 color display.

ElixiFont
This section contains information about solving common problems you might encounter when using
ElixiFont.
Minimum and maximum point size
The minimum supported point size is 4 points. The
maximum supported point size is 99 points.

Operational and error messages
This section lists operational and error messages issued by the Elixir Suite for Xerox products. These include messages displayed in the Message Area at the
top of the screen, and messages that display in message dialog boxes. Some dialog box messages require the user to enter a Yes or No response (such as
[Continue?])
Messages are shown in bold. Explanations for messages are given below the message in normal text.
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Messages are listed alphabetically for the following
products: ElixiSys Desktop, ElixiFont, ElixiForm, and
ElixiGraphics. Messages that begin with variable
parameters (for example, <filename>) are listed first in
each section.
ElixiSys Desktop messages
<filename> is not installed.
Copy the file to the appropriate input directory and
try the operation again.
<#> files now selected:
Displays the number of files selected in the current window.
* wildcard is not used correctly.
See your DOS or Windows documentation for the
proper use of wildcards.
<access> privileges are not active.
You attempted to perform an action for which
user privilege is not granted. See your internal
Elixir system administrator or the ElixiSys Desktop User Guide for information about user
privileges.
Application requires 32-bit extensions.
Windows error message. See your Microsoft
Windows documentation.
Application was designed for a different operating
system.
You are running an application using an incorrect
operating system or version of the operating
system.
Application was designed for MS-DOS 4.0.
You are using an incorrect DOS version for running an application.
A PUB file was not selected for archiving.
Select a PUB file and retry the operation.
At bottom of list.
You have reached the last item in the displayed
file list.
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A Tool Link is not defined for this window.
You can define a tool link for a window by selecting the [Tool Link] option from the Tools menu
while within the window. See the ElixiSys Desktop User Guide for more information.
Attempt was made to dynamically link to a task, or
there was a sharing or network-protection error.
Windows error message. See your Microsoft
Windows documentation.
Attempt was made to load a compressed executable file. The file must be decompressed before it
can be loaded.
Windows error message. See your Microsoft
Windows documentation.
Attempt was made to load a real-mode application
(developed for an earlier version of Windows).
The applications you use must be compatible with
the currently loaded version of Windows.
Attempt was made to load a second instance of an
executable file containing multiple data segments
that were not marked read-only.
Windows error message. See your Microsoft
Windows documentation.
At top of list.
You have reached the first item in the displayed
file list.
Cannot back up lower than \ELIXIR.
Your user privileges do not allow you to access
directories closer to the root than drive:\ELIXIR.
Cannot back up to a lower level.
Your user privileges do not allow you to back up
any closer to the root directory.
Cannot change to a lower level directory.
Your user privileges do not allow you to back up
any closer to the root directory.
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Cannot change to drive <drive:>.
Specify a valid drive letter.
Cannot copy a file into same UserFile directory.
You can only copy a file to another folder or duplicate it with a different name in the same folder
Cannot copy Elixir resources to these folders.
Elixir resources are stored in Elixir folders which
contain the Elixir-format files with extensions appropriate for that file type. For example, .ELX
files are Elixir-format form files stored in the Elixir
Forms folder (\ELIXIR\FORMS\ELIXIR\DEMO
directory).
Cannot copy files into this object.
The object (icon) into which you are attempting to
copy a file does not accept input files, or the input
file is not the correct format for that object.
Cannot copy from the Clipboard into this object.
Files in the clipboard can only be copied to the
Jobs folder.
Cannot copy input resources to output folders.
Use the Converter.
To copy a file to an Output folder, you must convert the file to the desired output format. Copy
your input file to the Converter icon and select a
format for the file. After the file is converted it is
placed in the Elixir Output folder that corresponds
to its file type.
Cannot copy more than 5 files at a time to the
Clipboard.
Decrease the number of files you are copying to
five or less and retry the copy operation.
Cannot display all files. Use filter.
The maximum number of files you can display in
a window is 1600. Pull down the Filter menu in
the file folder and select the [Enter Filter] option.
Enter a file filter to decrease the number of files
that display. For example, *.EXE.
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Cannot display the Logo.
The .BMP banner logo file specified in the Desktop Basic Setup dialog box is either too large to
display at the current screen resolution, not
enough memory is available, or is corrupt. The
maximum width and height for logo files by
screen resolution is:
VGA 528w x 300h
SVGA 864w x 540h
SIGMA 1388w x 816h
If reducing the height and width for your screen
resolution does not resolve the problem, close
any applications you are not working with and restart the Desktop to load the logo. If you receive
the same error again, close further applications or
exit and restart Windows.
Cannot enter an empty command string.
Enter a valid command for execution.
Cannot execute an empty command.
Enter a valid command for execution.
Cannot execute <filename>.
This file is not an executable file.
Cannot find <file> to run Dispatch.
Ensure that you have specified the proper path
for the file.
Cannot find <file> to run Usertool.
Ensure that you have specified the proper path
for the file.
Cannot load Desktop icons.
Ensure that you have the correct toolset selected
and the appropriate ElixiKey for that toolset attached. To check your toolset or change it, select
[Toolset] from the System menu in the Desktop.
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Cannot load image: <filename>.
The image you are printing could not be loaded
because it does not exist in the specified file path
or there is not enough memory to load it. Ensure
that you have specified the correct path, and
close any unused Windows applications to make
more memory available.
Cannot load the Logo.
The banner logo file specified in the Desktop Basic Setup dialog box does not exist in the \ELIXIR\PICS\BMP directory or is a corrupted file.
Cannot load this document; file may be corrupt.
The document you are opening or printing could
not be loaded because it does not exist in the
specified file path, there is not enough memory to
load it, or the file is corrupt. Ensure that you have
specified the correct path and close any unused
Windows applications to make more memory
available.
Cannot open file: <filename>.
Only Elixir-format files are editable. Check the
specified path to ensure that it is correct.
Cannot open <filetype>.
You can only open Elixir-format files for editing in
Elixir applications, or the file you are attempting to
open is in use by another application. Check to
ensure that the file is not in use by another
application.
Cannot open temporary file.
Occurs when you are accessing a 9700 diskette
and the application cannot open a temporary file,
or when any application cannot open a temporary
file. To create a directory for temporary files,
open (<F2>) the Converter Properties dialog box,
and click on the [Converter Properties] button to
display the Converter Properties dialog.
Enter a working directory or ensure that the current directory exists.
Cannot open the BTFONT.NAM file.
The \ELIXIR\FONTS\MAPS\BTFONT.MAP file
does not exist. Copy the file to the above directory and retry the operation.
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Cannot print file: <filename>.
Your file will not print because specified fonts are
missing, there is not enough memory, or the file is
not in the path specified. Ensure that all fonts are
available, you have enough memory to perform
the print operation, and that the specified file path
is correct.
Cannot read the 9700 diskette.
Ensure that a 9700-format diskette is loaded, that
it is not write-protected, and that you have specified Xerox 9700 as the diskette type. Check your
diskette drive for proper operation if the problem
is still not resolved.
Cannot run XLIST.
The XLIST utility for listing the contents of a 9700
diskette cannot be located. Ensure that the
XLIST.EXE file resides in your \ELIXIR directory
and retry the operation.
Cannot save this Job. Disk may be full.
The maximum number of pages (forms) per job is
99. Ensure that you have not exceeded this
maximum, or retry the operation after making
more disk space available.
Cannot save this Print Ticket. Disk may be full.
Retry the operation after making more disk space
available.
Cannot use these files in the Dispatcher.
You attempted to copy a file from the User Tools,
ElixiDoc, Tape, X9700 diskette, Elixir folder or
sub-folder, or PUBfile window to the Dispatcher.
Retry the operation using a valid file from other
than these folders.
Can only copy 9700 resources to tape.
You attempted to copy an incorrect file type to
tape. Refer to the ElixiSys Desktop User Guide
for a list of file types that can be copied to tape.
Can only open <filetype> files.
You attempted to open a non-Elixir file or a file
not linked to an application.
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Clipboard is full.
The Clipboard can hold a maximum of 10 files.
Close all windows first.
Before you perform certain operations, such as
an installation, you should close all open
windows.
Contour fonts not installed in this directory.
Contour fonts must be installed in the
\ELIXIR\FONTS\CONTOURS directory. Reinstall
Elixir Suite for Xerox or copy any Bitstream FaceLift format contour fonts to this directory.
Could not build the conversion list file.
You are running a DOS converter using a .BAT
file, and the Desktop cannot write to the .BAT file
due to disk errors or lack of space on the disk.
Retry the operation after making more disk space
available.
Could not copy the page: <filename>.
You specified an incorrect target directory, the
target disk is full, the file is already in use, or
there is a disk error. Check the specified target
directory path, ensure the file is not being used by
another application, or retry the operation after
making more disk space available.
Could not copy the PUB file: <filename>.
You specified an incorrect target directory, the
target disk is full, the file is already in use, or
there is a disk error. Check the specified target
directory path, ensure the file is not being used by
another application, or retry the operation after
making more disk space available.
Could not create the new file <filename>.
When issued while in a Diskette, Browse, or Elixir
folder window, the disk is full or there is a disk error. Additionally, when creating a new Elixirformat file, the blank file for the specified format
does not exist in the \ELIXIR\DESKTOP\SYSTEM\SOURCE\ directory.
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(A new Elixir-format file is created by copying a
BLANK.* file from this directory to the appropriate
Elixir resource directory). Retry the operation after making more disk space available, and ensure
that the BLANK.* file appropriate for the format
you are copying exists in the \ELIXIR\DESKTOP\SYSTEM\SOURCE directory.
Could not delete directory <dirname>.
Ensure that the directory you want to delete contains no files. Check the directory path to verify
that it is correct.
Could not execute the application.
You attempted to start an application from the
Desktop for which no .BAT file exists, or there is
not enough memory to start the application. Ensure that the .BAT file exists in the appropriate directory, and close any unused Windows
applications to make more memory available.
Could not load XAP for <filename>.
In UserTools, check the user application setup by
selecting the appropriate icon and then selecting
[Tool Props] from the Tools menu.
Could not make: <filename>.
The directory you specified does not exist. Check
the specified directory path and retry the
operation.
Could not make this directory.
The drive letter you designated does not exist or
the specified path is incorrect. Correct the specified path and retry the operation.
Could not open the page: <filename>.
The Elixir page which contains the names of all
fonts and graphics used in a form could not be
read during your .PUB file copy operation. Recreate the .PUB file and retry the operation.
Could not open this directory.
Ensure that the path you have entered corresponds to an existing directory.
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Could not open this resource window.
Ensure that the path you have entered corresponds to an existing directory.
Could not open this UserFile window.
Ensure that the path you have entered corresponds to an existing directory.
Could not write; disk may be full. <filename>.
Delete unneeded files on the disk to make more
disk space available.
Could not write to the printer port.
Check to see what output port you have selected,
and ensure that it is set up as your printer port.
Custom character set map does not exist.
Use a default character set map or ensure the
map you are referencing exists.
Directory <dirname> does not exist.
Ensure that the path you have entered corresponds to an existing directory.
Directory <dirname> is not empty; cannot delete.
Ensure that the directory you want to delete contains no files.
Disk could not be read.
The form you are trying to load cannot be loaded
due to a disk read failure. Check your disk for
proper operation and retry the load operation.
Diskette is not first one in the installation set.
Begin installation with the diskette labeled "Disk 1
of <#>". Subsequent diskettes are requested as
the installation proceeds.
Dispatcher <#> cannot be loaded, skipping action.
Ensure that the Dispatcher number entered corresponds to a command set up on the specified
number line in the Dispatcher.
Dispatch number must be between 1 and 12.
The Dispatcher stores up to 12 commands.
Specify the Dispatcher command line number for
the command you want (1 - 12).
Double-click to open a page.
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To view a form in ElixiForm, double-click on the
form icon.
Drive not ready or not installed.
Ensure that a diskette is loaded in the valid diskette drive you have selected.
Drive <drivename> is not removable.
You specified a hard disk drive as a diskette
drive. Specify a diskette drive letter and retry the
operation.
Dynamic-link library (DLL) file was invalid. One of
the DLLs required to run this application was
corrupt.
Windows error message. See your Microsoft
Windows documentation.
Elixir executable application is still running.
Wait until the Elixir application is completed before performing further operations or use <Alt> +
<Tab> to locate the Elixir Executive window and
close it.
ELX forms were not selected for conversion.
Select an .ELX form or forms to convert.
Enter a font mapping table.
Enter the name of the font mapping table you
want to use.
Enter a higher value.
The value you entered is below the minimum
value allowed for the operation (maximum values
are described in the "Troubleshooting" chapter.
Enter a lower value.
The value you entered exceeds the maximum
value allowed for the operation.
Enter a name for the font.
You did not specify a font name in the Outline-toraster font generator dialog box while using the
EFont Factory to convert a contour font to Elixir
format.
Enter a font name and retry the
conversion.
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Enter a 'Nickname'.
You did not enter a nickname for the application
for which you are creating an icon, or for the User
Tool with which you are creating a tool link. Enter
a nickname and retry the operation.
Enter a path to find the tool, starting with \.
You specified a working directory in the User Application Setup dialog box which does not start
with the "\" character. Begin the directory path
with this character, or to default to the \ELIXIR directory path, leave this option blank.
Enter a startup command.
You did not specify a command to execute in the
User Application Setup dialog box. Specify a
command and retry the operation.
Enter at least one point size.
You did not specify a point size in the Outline-toraster font generator dialog box while using the
EFont Factory to convert a contour font to Elixir
format.
Enter a point size and retry the
conversion.
Enter a valid file name.
You specified an invalid file name. Enter a file
name with eight or less characters in the stem
and three or less characters as the extension.
For example, ABCDEFGH.123.
Enter resolution of 300 or Cancel.
You did not specify 300 as the resolution in the
Outline-to-raster font generator dialog box while
using the EFont Factory to convert a contour font
to HP PCL format. Specify 300 as the resolution
and retry the conversion.
Error deleting format.
The file format(s) you selected for deletion in the
File Formats dialog box cannot be deleted due to
a disk error, or because the file is already in use
by another application. Check your disk for errors
and ensure that the file is not currently in use by
another application.
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Error opening output file: <filename>.
Your copy or duplication operation failed because
there is not enough disk space or there is a disk
error. Check your disk for errors and retry the operation after making more disk space available.
Error opening source file: <filename>.
Your copy or duplication operation failed because
there is not enough disk space or there is a disk
error. Check your disk for errors and retry the operation after making more disk space available.
Error opening window.
The Desktop cannot scan the directory you are
attempting to open due to a disk error. Check
your disk for errors.
Error renaming file: <filename>.
Ensure that the filename you enter complies with
standard file naming convention: an eight or less
character stem name followed by a three or less
character extension.
Error: Resource file not found.
Check the path specified for the location of the resource file.
Error writing PostScript font map.
Your PSFONTS.MAP file may be corrupted or
you have specified an incorrect directory path.
Check your PSFONTS.MAP file for errors and ensure that you have entered a valid directory path.
Executable file was invalid. Either it was not a
Windows application or there was an error in the
.EXE image.
Windows error message. See your Microsoft
Windows documentation.
Failed to allocate memory.
The Desktop was unable to allocate more memory as needed. Close any applications you are
not working with and try the operation again. If
you receive the same memory error again, close
further applications or exit and restart Windows.
Files have not been selected.
Select the files on which you want to perform the
operation and retry the operation.
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Files skipped.
During a delete, duplicate, or copy operation you
can specify not to perform the operation on a specific file.
Files were not selected for running the
Dispatcher.
To run a command from the Dispatcher, first copy
(drag and drop) a file to the Dispatcher icon, then
select a command line which contains the command you want to execute. If you selected the
[Prompt for parameters] option in the User Application Setup dialog box while setting up the Dispatcher command, you must specify a file as a
parameter to the command.
File was not found.
Ensure that the path and filename you enter is
correct.
Form is removed from the Clipboard.
The Clipboard can temporarily store form files for
use in jobs. When you move a form that is stored
in the Clipboard to the job you are creating, the
form is moved from the Clipboard and a copy no
longer exists there.
Further Elixir backup privileges are not active.
Your user privileges do not allow you to access
directories closer to the root than the \ELIXIR
directory.
Ignoring unknown command: <filename>.
Ensure that the command you enter is an executable file, that it is referenced by the correct file
name, and that it resides in the directory
specified.
Image too large to convert.
When converting an Elixir .LP3 image to a .LGO
image, the maximum size .LGO you can create is
128K.
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INSTALL.LOG file was not found.
The INSTALL.LOG file you want to view from the
Desktop Diagnostics dialog box does not exist.
The INSTALL.LOG file is not required for running
Elixir Suite for Xerox software.
Invalid files were selected for conversion.
Only files in supported formats are convertible to
other supported formats. Ensure that the format
of the file you want to convert is supported.
Invalid files were selected for transforming.
Only files in supported formats are transformable
to other supported formats. Ensure that the format of the file whose components you want to
transform is supported.
Library required separate data segments for each
task.
Windows error message. See your Microsoft
Windows documentation.
Logo is too large.
The .BMP banner logo file specified in the Desktop Basic Setup dialog box is too large to display
for the screen resolution or memory available, or
is corrupted. Select a smaller .BMP file to display, or reduce the logo file size using ElixiGraphics. The maximum width and height for logo files
by screen resolution is:
VGA 528w x 300h
SVGA 864w x 540h
SIGMA 1388w x 816h
If reducing the height and width for your screen
resolution does not resolve the problem, close
any applications you are not working with and restart the Desktop to load the logo. If you receive
the same error again, close further applications or
exit and restart Windows.
LP3 files were not selected for conversion.
Select a .LP3 file or files and retry the operation.
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Maximum number of allowable pages in the Job
was exceeded.
The maximum number of pages (forms) allowed
per job is 99. Remove pages from the job until
the number is less than the maximum allowed.
No files were matched.
A file you are attempting to select using a Selection menu option is not currently displayed in the
window because it does not match a filter you
previously activated using the Filter menu. For
example, you enter a *.BAK filter to display all
files whose extensions are .BAK, and then try to
select all .ELX files using a Selection menu option. Turn off the current filter by pulling down the
Filter menu and selecting [Turn Off Filter], then
reselect the file or files using a Selection menu
option.
No property sheet available for this converter.
There is no default property sheet for setting up
options for the converter. Select the options you
want at the time of conversion.
Not enough memory available for Desktop.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and restart Windows.
Not enough memory available for file list. Exiting.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and restart Windows.
Not enough memory available for this form.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and restart Windows.
Not enough memory available to copy.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and restart Windows.
Not enough memory available to copy files.
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Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and restart Windows.
Not enough memory available to create window.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and restart Windows.
Not enough memory available to define windows.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and restart Windows.
Not enough memory available to perform Loader
operations.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and restart Windows.
Not enough memory available to select files.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and restart Windows.
Number of objects selected: <n>
You have select <n> files in the current directory.
Offset X for A3 must be a number from 0 to 4962.
Enter a number between the 0 and 4962.
Offset X for 11x17 must be a number from 0 to
5100.
Enter a number between 0 and 5100.
Offset X of page one has to be less than page two.
Enter an offset value that is less than the offset
value on page two..
Offset Y for A3 must be a number from 0 to 3508.
Enter a number between 0 and 3508.
Offset Y for 11x17 must be a number from 0 to
3300.
Enter a number between 0 and 3300.
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Only ELIXIR-format files can be edited.
You cannot open or edit non Elixir-format files using any of the Desktop applications.
Only ELIXIR-format files can be opened.
You cannot open or edit non Elixir-format files using any of the Desktop applications.
Only .ELX forms can be copied to the Clipboard.
The Clipboard temporarily stores form files during
job creation. Jobs are created from Elixir-format
(.ELX) files only.
Only .ELX forms can be copied to the Job window.
Jobs are composed of pages, or forms, which are
.ELX Elixir-format form files.
Only Forms, Fonts, Graphics, or Documents can
be converted.
You cannot perform conversion operations on
other than form, font, graphics, or document files.
Only Forms, Fonts, Graphics, or Documents can
be transformed.
You cannot perform transformation operations on
other than form, font, graphics, or document files.
Only 9700 resources can be copied to a 9700 format diskette.
Ensure that the files you are copying are 9700 format files.
Only one * wildcard character can be used in an
MVS dataset.
Check for use of more than one wildcard. See
your Windows documentation for more information about using wildcards.
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Outline fonts not installed in this directory.
Outline fonts (EFont Factory fonts) are installed in
the \ELIXIR\FONTS\CONTOURS directory. Reinstall Elixir Suite for Xerox or copy any Bitstream
FaceLift format contour fonts to this directory.
Page not in given directory.
Recheck the page (form) file name for accuracy,
and confirm that the path name you entered is
correct.
Path was not found.
Recheck the path name you entered for validity.
Pick an icon for copy destination.
Click on the icon into which you want to copy the
file. For Elixir folders, the file remains attached to
the cursor until you click on the inner folder which
represents the file format of the attached file.
Point size must be in the range 2 to 50.
Enter a number between 2 and 50.
Point size must be in the range 2 to 99.
Enter a number between the 2 and 99.
Printer form feed did not operate.
Check your printer to ensure it is turned on and in
the proper mode for form feed operations.
Publication File copy is canceled.
The PUB file copy operation has been canceled
as requested.
Removing page from the Job.
The form (page) file you specified for deletion is
being removed from the job.
Scheduler Actions not saved. Disk may be full.
Delete any unnecessary files to create more disk
space on the current disk.
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Scheduler Actions not started.
The Desktop cannot allocate enough memory for
the specified Scheduler action. Close any applications you are not working with and try the operation again. If you receive the same memory
error again, close further applications or exit and
restart Windows.
Scheduler Action support is not installed.
See your internal Elixir system administrator for
more information.
Select a file for printing.
Select a file before starting the current printing
operation.
Select a form from the Clipboard.
Select a form from the Clipboard and move or
copy it to the desired folder.
Select at least one .ELX form to be included in the
Pub File.
A .PUB file must contain at least one form to be
saved as a PUB file.
Select a UserTool first.
Select a UserTool before starting the current
operation.
Select contour(s) and copy to the Converter.
Select a contour font from the \ELIXIR\FONTS\CONTOURS folder to copy to the Converter
icon.
System was out of memory, executable file was
corrupt, or relocations were invalid.
Windows error message. See your Microsoft
Windows documentation.
Tape driver is not loaded.
Your CONFIG.SYS file doesn't contain an entry
for loading the specified tape driver, or the entry it
contains is incorrect. Check your CONFIG.SYS
file for this entry and ensure that the file and path
names are correct.

A-28

ELIXIR GETTING STARTED GUIDE

OPERATIONAL AND ERROR MESSAGES

Testing for Scheduler Action <n>.
The Scheduler is in processing mode searching
for the specified action to perform.
The file already exists: <filename>.
You can overwrite the existing file, or rename the
file you are copying or duplicating to avoid overwriting the existing file.
There is no input folder for this resource.
The format of the file you are copying is not a
supported format.
There was insufficient memory to start the
application.
Close any applications you are not working with
and try starting the application again. If you receive the same memory error again, close further
applications or exit Windows and start Windows
again.
This directory does not exist.
Confirm that the directory path you entered is correct, or create the missing directory using the
System menu [Make directory] option.
This document file is empty.
There are no form (page) files referenced within
the document file. Edit the ASCII-format .DAT
document file to list the forms you want included
in the document.
This icon cannot be opened.
Some Desktop icons are used for setting properties only. Click on the icon with the right mouse
button to view or set its properties.
This is not a 9700 format diskette.
Replace the current diskette with a 9700 format
diskette.
This is not an DOS-Elixir diskette.
To format a diskette as a DOS-Elixir diskette,
open the Diskette icon, and with a diskette in the
selected diskette drive, select [DOS Elixir] as the
Diskette Type option, then select [Perform FORMAT] as the Diskette Access option.
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This name is reserved by DOS.
Rename the file for which you received the error.
This Print Ticket is empty.
Specify printing options by selecting print ticket
options or entering information in the print ticket.
To access the print ticket, open the job and
double-click on the PrTicket icon for the job.
Click on [OK] in the Page Imposition Options dialog box (if applicable) to display the Job Print
Ticket dialog box.
This object has no properties.
There is no default property set up dialog associated with the icon you clicked on.
This UserTool has not been defined.
To set the properties for a UserTool, right-click on
the UserTool icon or select [Tool Props] from the
Tools menu when the icon is selected. Specify
the icon properties in the User Application Setup
dialog box that displays.
Tool not found.
Check the UserTools folder to ensure that the tool
exists.
Transformer utilities not installed.
Stand-alone utilities such as PACK, STRIP, and
NameUDK need to be installed before you can
perform transform operations.
Type of executable file was unknown.
Common executable file extensions are .EXE,
.BAT, and .COM. Ensure that the file you are
specifying is an executable file.
Unknown command: (filename) ignoring.
Ensure that the filename and path you specify for
the command are valid, and that the command is
an executable file.
User-defined printer is not set up.
You need to set up your printer options by clicking
on the [Setup] button in the Printer dialog box before you can print to a printer.
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Usertool: <filename> does not exist.
Check the properties of the UserTool in the UserTools folder by right-clicking on the icon. Ensure
that the information entered in the User Application Setup dialog box is correct. You can use the
[Browse] button in the dialog box to check the directory paths and filenames you enter.
Usertool: <file>.XAP cannot be loaded, skipping
action.
Check the properties of the UserTool in the UserTools folder by right-clicking on the icon. Ensure
that the information entered in the User Application Setup dialog box is correct. You can use the
[Browse] button in the dialog box to check the directory paths and filenames you enter.
Warning: Can not create LOG file <filename>.
The log file name you specified in the Message
Options dialog box is invalid. Enter another file
name and ensure that is has a .LOG extension.
Warning: Could not open <filename>.
Only Elixir-format form, font, and graphics files
can be opened or edited within the Desktop via
their corresponding applications. You can also
open and view text or ASCII-format files using a
text editor through the Dispatcher or a DOS command. Ensure that you have entered a valid filename and path.
Warning: Could not update \ELIXIR\<filename>
file.
Ensure that you have specified the correct filename and path, and that the file you want to update is not read only.
Warning: Disk space is less than <n> KB.
The low disk space threshold you specified in the
Desktop Basic Setup dialog box has been
reached. You should delete unnecessary files to
create more disk space, or lower the specified
threshold.
Warning: Drive <drive:> is not available.
Specify an available drive or wait until a busy
drive becomes available.
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Warning: \ELIXIR\DESKTOP.INI is corrupted.
Indicates that there was a problem on your hard
disk. Restart the ElixiSys Desktop (the Desktop
creates a new DESKTOP.INI file with default settings) to remove the error message.
Warning: Missing ElixiKey for the <toolname>
Toolset; conversions not possible.
You must have the proper ElixiKey installed to
perform this file conversion. Connect the proper
ElixiKey to the LPT1 parallel port of your PC. To
view the ElixiKey(s) attached to your PC, click on
the [Show installed ElixiKeys] option in the Desktop Diagnostics dialog box.
Warning: Zero length file detected:
Retrying
action.
The Scheduler attempted to open a file that is in
use by another application. The Scheduler cannot currently process the file, but will periodically
retry the operation.
Windows version was incorrect.
Windows error message. Windows detected that
the non-Elixir application you are attempting to
run from the Desktop is incorrect. See your Microsoft Windows documentation for more
information.
Working directory does not exist.
Ensure that the path you have entered for the
command to execute is the correct path, and that
the executable resides in the specified directory.
ElixiForm messages
<number> B&W elements hidden.
The number of black and white elements that are
not displayed (when using the <Alt> + <F9> toggle to show only color elements).
<number> color elements are hidden.
The number of color elements that are not displayed (when using the <Alt> + <F9> toggle to
show only black and white elements).
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<element> - filtered out.
You are attempting to select an element that was
excluded (set to OFF) in the Selection Group
Filter.
All colors are being used: Cannot be deleted.
You attempted to delete one or more colors from
the local palette, all of which are used on the
form.
All elements in the group will be deleted. OK to
delete?
This message requests confirmation for deleting
all elements in the selected group.
All <element type(s)> elements will be deleted. OK
to delete?
More than one element is on the form and you
are attempting to delete all elements using <Ctrl>
+ <Del>.
All patterns are being used: Cannot be deleted.
You attempted to delete all unused patterns from
the local pattern palette (by pressing <Ctrl> +
<Del>) and all patterns are used on the form.
Autosave ...
This message momentarily displays during form
autosave.
B&W mode. Color display toggle ignored.
This message displays when a black and white
form is loaded and you press <Alt> + <F9> to toggle color.
BPSD tags are hidden.
Boilerplate Space Definition Tags (used by
DocuMerge for specifying variable data) are not
displayed in text.
BPSD tags are shown.
Boilerplate Space Definition Tags (used by
DocuMerge for specifying variable data) are displayed in text.
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Cannot delete any predefined patterns.
You attempted to delete one of the predefined
patterns (white, light gray, medium gray, dark
gray, or black) from the local pattern palette.
Cannot delete a predefined color.
While in Full Color mode, you attempted to delete
the black color from the local palette (black is the
only predefined color in full color mode).
Cannot load form.
A software error occurred when attempting to
load the requested form (one or more files may
be corrupt). Retry the operation.
Cannot read from disk.
A software error occurred when attempting to
read from the hard disk (one or more files may be
corrupt). Retry the operation.
Color is being used; Cannot be deleted.
You attempted to delete a color from the Color
menu (in full color mode) while it is in use on the
form.
Could not create element.
A software error occurred when attempting to create the requested element (disk may be full). Retry the operation.
Could not create Job Print Ticket.
This message displays when proof printing a form
on an XES printer (using [Print Special] from the
File menu) and a software error prevents creating
a Job Print Ticket for the form (required for printing on XES printers). See the ElixiSys Desktop
User Guide for information about the Job Print
Ticket.
Could not create the .DAT file.
This message displays when proof printing a form
on an XES printer (using [Print Special] from the
File menu) and a software error prevents creating
a .DAT file for the form (a .DAT file is required for
printing on XES printers). Retry the operation or
manually create the .DAT file.
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Could not duplicate the element.
A software error occurred when copying the selected element. Retry the operation.
Could not open AUTOBACK.ELX file.
A software error occurred when trying to load the
AUTOBACK.ELX backup form file. Retry the
operation.
Could not open catalog file: <filename>
This message displays when ElixiForm cannot locate the XEROX.CAT or XEROX1.CAT files
which should normally be located in
drive:\ELIXIR\DESKTOP\SYSTEM\PATTERNS.
Check the directory for the files and if not there,
reinstall ElixiForm.
Could not open output page file.
This message displays when DOS is unable to
open a file to which a form is to be saved. This
occurs when you attempt to save a form and either the disk is full or the target file is on a diskette that is write-protected.
Could not open the form: <filename>.
A software error occurred when loading the selected form or the form file was corrupt. Retry the
operation or check the form.
Could not write AUTOBACK.ELX file.
A software error occurred when trying to write the
backup file, AUTOBACK.ELX. Check available
disk space.
Could not write form to disk.
A software error occurred when attempting to
save the form. Retry the operation.
Create temporary page file failed.
This message displays when proof printing a form
on an XES printer (using [Print Special] from the
File menu) and a software error prevents creating
the temporary form file (required because the
user may have edited, but not saved the current
form). A possible cause could be a full disk.
Check the disk capacity and retry the operation.
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Decimal point is not allowed.
Entering a decimal point in the field (numeric box)
is not allowed, reenter a number without a decimal point.
Default font not found in \ELIXIR\FONTS\SCREEN
subdirectory. Form not loaded .
When loading a form that does not contain any of
the fonts in the current font list, ElixiFont attempts
to substitute a default font from the above directory. If a default font is not found, the form is not
loaded and the above message is issued. Check
your hard disk capacity and reinstall ElixiForm.
ElixiKey not detected. Form cannot be saved.
Make sure the correct ElixiKey is connected to
the parallel port.
Error: Duplicate font:
This message displays when you attempt to replace a font in the font list with a font that is already specified in the font list. Delete the second
instance of the font.
Error occurred when loading font: <filename>.
A software error occurred when attempting to
load the requested font. The requested font file
may be corrupt.
Font List: <filename> already exists Overwrite?
This message displays when attempting to save a
font list file with an already existing name. Retry
the operation with another name.
Font list is empty. Cannot add text.
Add one or more fonts to the font list before attempting to add text to the form.
Form name: <filename> already exists. Overwrite?
This message displays when attempting to save a
form with an already existing name. Retry with
another name.
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Form name: <filename> has not been saved.
Save?
This message displays when attempting to exit
ElixiForm or load another form before saving the
current one.
Form name: <filename> will be deleted.
This message requests confirmation for deleting
the selected form (AUTOBACK.ELX cannot be
deleted).
GEM text formatting mode. <CR> disabled if wrap
is ON.
When the [GEM Compatible Text Formatting] option in the Text and Font Options dialog box is selected, the <Enter> key is disabled if word wrap is
set to ON.
Importing text: <filename> position - free.
Text from the specified file is being imported in
"free text" mode.
Importing text: <filename> position - locked.
Text from the specified file is being imported in
"locked text" mode.
Loading Colorshade Mapping Table...
This informational message displays when loading the mapping table when changing between full
color and highlight color modes.
Loading configuration file...
This informational message displays when first
starting ElixiForm.
Loading ink patterns...
This informational message displays when loading inks patterns.
Loading RGB values...
This informational message displays when loading RGB values.
Loading XDP gray values...
This informational message displays when loading XDP gray scales.
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Lower range limit has been reached.
You attempted to enter a number in a field (numeric display box) that is too small. Backspace
to clear the message and enter a larger number.
Mapping inks...
This informational message displays when
matching ink names after a highlight color palette
is changed.
Mapping local palette...
This informational message displays when mapping between full color and highlight color modes.
Negative value is not allowed.
You attempted to enter a negative value in a field
(numeric display box) that disallows it. Retry with
a positive value.
No B&W elements are hidden.
This message displays when a form does not
contain any black and white elements (when using the <Alt> + <F9> toggle to show only color
elements).
No color elements are hidden.
This message displays when a form does not
contain any color elements (when using the <Alt>
+ <F9> toggle to show only black and white
elements).
No image selected.
An image was not selected for pasting in the
form. Select an image and try again.
No text was selected.
You attempted to perform an operation on text
without first selecting the text.
One B&W element hidden.
This message displays when a form contains one
black and white element (when using the <Alt> +
<F9> toggle to show only color elements).
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One color element is hidden.
This message displays when a form contains one
color element (when using the <Alt> + <F9> toggle to show only black and white elements).
One <element type> element will be deleted. OK to
delete?
This message displays when the user attempts to
delete all form elements by pressing <Ctrl> +
<Del> and the form contains only one element.
Only two decimal places are allowed.
You attempted to enter more than two decimal
places in a field (numeric display box). Retry with
two decimal places or less.
Open the text element first.
This message displays when you attempt to use
the soft keyboard without first clicking in the form
work area to position text.
Pattern is being used: Cannot be deleted.
You attempted to delete a pattern from the local
pattern palette that was added from the remote
pattern palette to the local pattern palette or was
used on the form.
Replace font <filename> with <filename>?
This message displays when you attempt to replace a font in the font list with a new font.
Saving configuration file...
This message displays momentarily when selecting [Save Configuration] from the System menu.
The message also displays when [Save State on
Exit] in the Usage Switches dialog box (displayed
from the System menu) is selected and the user
exits ElixiForm.
Sticky Lines is set to OFF.
The Sticky Lines feature is off.
Sticky Lines is set to ON.
The Sticky Lines feature is on.
Text box is bigger than the page size.
You have specified a text box that exceeds the
page dimensions. Reduce the text box size.
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Text box size is below allowed limit.
The lower limit for text box width and height is
zero. Increase the size of the text box.
Text import position - free.
This informational message displays when importing text in "free text" mode. Use <F11> to
toggle between free and locked text.
Text import position - locked.
This informational message displays when importing text in "locked text" mode. Use <F11> to
toggle between free and locked text.
The font path does not exist.
This message displays when you attempt to specify a non-existing path for the Fonts directory in
the Filing Options dialog box.
The form path does not exist.
This message displays when you attempt to specify a non-existing path for the Forms directory in
the Filing Options dialog box.
The text path does not exist.
This message displays when you attempt to specify a non-existing path for the Text directory in the
Filing Options dialog box.
This file is not an ELX form or is corrupted.
A software error occurred when loading the form.
Ensure that the form is an Elixir-format form.
Too many decimal places..
You have specified too many decimal places in a
field (numeric display box). Retry with two or
fewer decimal places.
Upper range limit has been reached.
Enter a smaller number in the numeric display
box.
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Warning: Font list contains default fonts. Save
anyway?
This warning message displays when a missing
screen font is replaced by the default font and the
user attempts to save the form. Save the file with
a new name so that the original font name is retained in the font list.
Warning: Loaded form contains <number> unsupported elements.
This message displays when loading a form that
was converted from a non-Xerox format. NonXerox forms may contain elements that are not
supported by Xerox printers.
Warning: Loaded form contains an unsupported
element.
This message displays when loading a form that
was converted from a non-Xerox format. The
non-Xerox form contains one element that is not
supported by Xerox printers.
Warning: The element exceeding the page size
will not be saved. Continue anyway?
This message displays when the [Check Page
Boundaries] option in the Page Properties dialog
box is not selected and at least one element
crosses the page boundary.
Writing form to temporary file failed.
This message displays when proof printing a form
on an XES printer (using [Print Special] from the
File menu) and a software error prevents creating
the temporary form file (required because the
user may have edited, but not saved the current
form). A possible cause could be a full disk.
Check the disk capacity and retry the operation.

ELIXIR GETTING STARTED GUIDE

A-41

TROUBLESHOOTING

ElixiGraphics messages
<filename> has not been saved. Continue anyway?
You are closing an image file without saving the
changes to the file. If you want to save the current image, pull down the File menu and select
[Save] or press <Ctrl>+<S>.
BLACK & WHITE image.
A black-and-white image is currently loaded.
BLACK & WHITE image converted from HIGHLIGHT COLOR image.
Your highlight color (two-plane) image has been
converted to a black-and-white (one-plane) image. This operation cannot be undone.
Block copied to clipboard.
The image or image area is copied and placed in
the Windows clipboard leaving the original image
or image area unchanged. To paste the image or
image area, pull down the Edit menu and select
[Paste] or press <Ctrl> + <V>.
Block deleted.
The image area you marked for deletion has
been deleted.
Block inserted.
The image or image area in the Windows clipboard is placed in your image.
Block moved to clipboard.
The image or image area is cut and placed in the
Windows clipboard leaving a blank space in place
of the image or image area. To paste the image
or image area, pull down the Edit menu and select [Paste] or press <Ctrl> + <V>.
Building reduced view ...
Your image is reduced. To restore your image to
the original size click on the up arrow in the toolbar or press <+>.
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Cannot allocate cut view ...
Not enough memory to perform the selected operation. Close any applications you are not working with and try the operation again. If you
receive the same memory error again, close further applications or exit and then restart Windows.
Cannot break up the image.
The number of Horizontal and/or Vertical pieces
you specified in the Breakup Image dialog box is
more than 31. Reduce the number of Horizontal
and/or Vertical pieces to less than 31 and try the
operation again.
Cannot create form trace-over template.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
or
The image is too large. Reduce the size of the
image (using the Resize transformation operation) and try the operation again.
Cannot create %s font files to save to.
Before tiling a graphic into a font, you must first
load the font you want to tile the graphic into.
Cannot create screen version.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
or
The image is too large. Reduce the size of the
image (using the Resize transformation operation) and then create a screen version.
Cannot create <filename> font files to save to.
Current disk may be full. Delete any unnecessary
files and try the operation again.
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Cannot create .TXT file for writing in text.
Not enough memory to perform the selected operation. Close any applications you are not working with and try the operation again. If you
receive the same memory error again, close further applications or exit and then restart
Windows.
Cannot distort area (not enough memory).
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
or
Reduce the size of the image (using the Resize
transformation option) and try again.
Cannot load an image, leaving ...
Not enough memory to load the current image.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
Cannot load font <filename>.
Ensure that you have specified a font filename
that exists.
or
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
Cannot load image <filename>.
Not enough memory to load the selected image.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
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Cannot mirror area (no memory).
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
or
Reduce the size of the image (using the Resize
transformation option) and try the operation
again.
Cannot resize bitmap (not enough memory).
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
or
Reduce the resize percentage and try the operation again.
Cannot rotate bitmap (not enough memory).
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
or
Reduce the size of the image (using the Resize
transformation option) and try the operation
again.
Cannot white out area (area was not selected).
If you select the [Outside area] option when performing the Clear transformation operation and
do not select an area, this message displays. Select an image area by dragging the mouse, and
try the operation again.
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Clear operation failed.
Not enough memory to perform the Clear operation. To clear inside or outside a selected image
area you must first select the image area.
or
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
Clipboard is empty.
There is nothing in the Windows clipboard to
paste.
Conversion completed.
The conversion from one image color to another
has been completed.
Converting ...
The conversion from one image color to another
is in process.
Converting color to HC or HC to B&W. Continue?
When converting highlight color (two-plane) images to and from black-and-white (one-plane) images, you are prompted to verify continuing the
operation. This operation cannot be undone.
Copying image tile...
A tile is being copied to your image.
Could not print.
The image is too large, or the target printer is out
of paper or is off-line.
Could not save image <filename> to disk.
There is not enough disk space available on the
current disk. Delete any unnecessary files to create more disk space and try the save operation
again.
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Could not save the font; disk may be full.
There is not enough disk space available on the
current disk. Delete any unnecessary files to create more disk space and try the save operation
again.
Creating B&W bitmap from color bitmap ...
Your highlight color image is being converted to a
black-and-white image.
Creating color bitmap from B&W bitmap ...
Your black-and-white (one-plane) image is being
converted to a highlight color (two-plane) image.
Creating default image ...
The image you want to create cannot be created
due to size or a missing parameter. A default image is created instead.
Change the height and width values in the Image
Attributes dialog box and ensure you have entered all option values for which you do not want
the default value used.
Creating pure highlight color image ...
The color image you loaded is being converted to
a highlight color image, since ElixiGraphics does
not support full color image editing.
Creating temporary file ...
The file created is for the current session of ElixiGraphics only.
Debolden operation failed.
Not enough memory to perform the Lighten operation. Close any applications you are not working with and try the operation again. If you
receive the same memory error again, close further applications or exit and then restart
Windows.
Decimal point is not allowed.
Enter a value without a decimal point and try the
operation again.
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Disk image <filename> has different number of
color planes. Save anyway?
The image you are saving has a different number
of color planes than the image currently on disk.
Select [Yes] to overwrite the current image on
disk and replace it with the new one. Select [No]
if you do not want to overwrite the current image
on disk. If you select [No], save the current image with a new filename.
Drawing is not supported at reduced view.
You cannot use the drawing tools while in a reduced view. Click on the up arrow, until the image displays at 1X magnification and try the
operation again.
ElixiKey not detected. Cannot save files, print images or load data into clipboard.
Your ElixiKey is not connected to the parallel port
(LPT1) of your PC. Connect your ElixiKey to the
parallel port and try the operation again.
Embolden operation failed.
Not enough memory to perform the Darken operation. Close any applications you are not working with and try the operation again. If you
receive the same memory error again, close further applications or exit and then restart
Windows.
Error occurred when creating temporary disk image.
Not enough memory to perform the selected operation. Close any applications you are not working with and try the operation again. If you
receive the same memory error again, close further applications or exit and then restart
Windows.
Error saving Logo Control Text file.
The current disk may be full. Delete any unnecessary files to create more disk space on the current disk and try the operation again.
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File <filename> already exists. Overwrite?
The file you are trying to save already exists. If
you do not cancel your save operation, the existing file is overwritten.
Filter operation failed.
Not enough memory to perform the Filter operation. Close any applications you are not working
with and try the operation again. If you receive
the same memory error again, close further applications or exit and then restart Windows.
Font <filename> has not been saved. Save?
Select [Yes] if you have edited a font and want to
save your changes. Select [No], if you do not
want to save your changes.
Halftone operation failed.
Not enough memory to perform the Halftone operation. Close any applications you are not working with and try the operation again. If you
receive the same memory error again, close further applications or exit and then restart
Windows.
HIGHLIGHT COLOR image.
A highlight color image is currently loaded.
HIGHLIGHT COLOR image converted from BLACK
& WHITE image.
A black-and-white (single-plane) image has been
converted to a highlight color (two-plane image).
HIGHLIGHT COLOR image converted from FULL
COLOR image.
The full color image has been converted to a
highlight color image. This occurs if you try to
load a full color image in ElixiGraphics, since full
color image editing is not supported.
Image <filename> already exists. Overwrite?
The image you want to save already exists. Select [Yes] if you want to overwrite the existing image. Select [No] if you do not want to overwrite
the existing image.
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Image <filename> does not exist.
The image you are trying to load does not exist.
Ensure that the filename is correct and try the operation again.
Image <filename> has not been saved. Save?
Select [Yes] to save the current image. Select
[No], if you do not want to save the current image.
Image name is required.
Creating a new image requires you to specify an
image name in the Image Attributes dialog box.
Image size will exceed available memory.
The image size specified in the Image Attributes
dialog box is too large. Specify smaller height
and width sizes and try the operation again.
Maximum image size is based upon the virtual
memory (physical memory and Windows swap
file size) available within Windows.
Image width and height must be non-zero.
Image width and height must be a positive number. Enter positive numbers for width and height
in the Image Attributes dialog box and try the operation again.
Insufficient memory, aborted ...
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Maximum image size and other memory operations are based upon the virtual memory (physical
memory and Windows swap file size) available
within Windows.
Invert operation failed.
Not enough memory to perform the Invert operation. Close any applications you are not working
with and try the operation again. If you receive
the same memory error again, close further applications or exit and then restart Windows.
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Loading configuration file ...
The configuration file which contains the default
settings you saved for ElixiGraphics is being
loaded.
Loading Elixir font file ...
The font file you selected is being loaded.
Loading Pattern files ...
The pattern file you selected is being loaded.
Lower range limit reached.
You attempted to enter too small a value in a field
(numeric display box). Backspace to clear the
message and enter a larger number. With the
cursor in the numeric display box, you can set the
minimum allowable value by pressing <Ctrl>-click,
or the maximum allowable value by pressing
<Shift>-click.
Moving image tile ...
The image tile you selected is being moved.
Negative value is not allowed.
The value specified cannot be negative. Specify
a positive value and try the operation again.
Not enough memory is available to create image
<filename>.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Maximum image size is based upon the virtual
memory (physical memory and Windows swap
file size) available within Windows.
Not enough memory to change image format.
Transform operation in progress ..
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit and then restart Windows.
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Outline operation failed.
Not enough memory to perform the Outline operation. Close any applications you are not working with and try the operation again. If you
receive the same memory error again, close further applications or exit and then restart
Windows.
Performing zoom operation ...
The current image is being magnified.
Printing canceled.
Your print operation has been canceled.
Resetting image to last saved version... Continue?
Select [Yes] to undo all edits since the last save
operation. Select [No] if you do not want to undo
all edits since the last save operation.
Saving configuration file ...
All of the settings in the current session of ElixiGraphics are being saved as defaults to a configuration file.
Select any screen area using the mouse.
Drag the mouse to select an area to paste to the
Windows clipboard.
Shift operation failed.
Not enough memory to perform the Shift operation. Close any applications you are not working
with and try the operation again. If you receive
the same memory error again, close further applications or exit and then restart Windows.
Swapping color planes ...
Switching all elements in a Highlight color or
Black-and-white plane to the opposite plane.
There is nothing to redo.
There is no previous operation to redo.
There is nothing to undo.
There is no previous operation to undo.
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This font was loaded in read-only mode.
This message displays if you try to copy an image
area into a currently loaded font/clipart library set
using the Import transformation operation. Select
the Export transformation operation and try the
operation again.
This function is supported at 1X magnification
only.
Use the up or down arrows in the toolbar to display your image at a 1X magnification and try the
operation again.
Too many decimal places.
Enter a number with fewer decimal places.
Transformation completed.
The transformation operation you selected has
been performed.
Unexpected change of toolset. Stop editing and
reload the image.
Reload the image and try the operation again.
You cannot change toolsets in the ElixiSys Desktop during an editing or creation session in an
Elixir application.
Upper range limit reached.
You attempted to enter too large a value in a field
(numeric display box). Backspace to clear the
message and enter a smaller number. With the
cursor in the numeric display box, you can set the
minimum allowable value by pressing <Ctrl>-click,
or the maximum allowable value by pressing
<Shift>-click.
Wrong color of the starting point.
If you have [Interior] selected for the Floodfill tool,
place the cursor in an area containing the current
FG color and try the operation again. If you have
[Solid] selected for the Floodfill tool, place the cursor in an area bound by the current FG color and
try the operation again.
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ElixiFont messages
<Transform operation name> the whole font?
This message requests confirmation for transforming the entire font.
Area is outside the cell.
This message displays in Edit Bitmap mode when
the user presses <Enter> after using the <Shift>
+<arrow> keys and moves the Move or Copy
Area box outside the character cell.
Area was copied to the clipboard.
The selected area was copied and written to the
clipboard.
Area was deleted.
The selected area was deleted.
Bitmap was copied to the clipboard.
The character bitmap was copied to the Windows
clipboard.
Bitmap was cut and saved to the clipboard.
An area was not selected, so the whole character
bitmap was cut and saved to the Windows
clipboard.
Bitmap was deleted.
The character bitmap was deleted (undo will restore this operation).
Bitmap was inserted from the clipboard.
The character previously saved to the Windows
clipboard was copied to the currently displayed
character cell.
Blend submode.
The Blend tool has been selected.
Buffer is full.
You attempted to insert more than 1024 characters in the sampling pad. The character limit for
the sampling pad is 1024.
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Cannot blend with a blank character.
While in Edit Bitmap mode, the user attempted to
blend a character with a NULL or a SPACING
character.
Cannot copy a character onto itself.
You attempted to copy a selected character to the
same character position.
Cannot cut or copy the selected area.
A software error occurred during a Windows cut
or copy to clipboard operation. Check your remaining disk space and retry the operation.
Cannot embolden a blank character.
You attempted to embolden a NULL or a SPACING character.
Cannot filter a blank character.
You attempted to filter a NULL or a SPACING
character.
Cannot halftone a blank character.
You attempted to apply halftoning to a NULL or a
SPACING character.
Cannot load character bitmaps for the font name.
The font file name you are trying to load is corrupt
or one or more components are missing.
Cannot load .HDR or .GLH files for the font name.
The .HDR or .GLH files for the specified font are
either missing or corrupt. Reinstall the fonts and
retry the operation.
Cannot mirror a blank character.
You attempted to mirror a NULL or a SPACING
character.
Cannot open a source file for merging.
A software problem is preventing loading the second (source) font for merging. The source font
may be corrupt or have one or more components
missing.
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Cannot open sampling pad.
A software error is preventing opening the sampling pad. Exit ElixiFont and retry the operation.
Cannot open the Edit Bitmap window.
A software error has occurred that is preventing
opening the Edit Bitmap Window. Retry the
operation.
Cannot paste the selected area.
An error occurred in the Windows clipboard paste
operation. Retry the operation. If necessary, exit
ElixiFont and retry the operation.
Cannot rotate a blank character.
You attempted to rotate a NULL or a SPACING
character.
Cannot shift a blank character.
You attempted to shift a NULL or a SPACING
character.
Cannot slant a blank character.
You attempted to slant a NULL or a SPACING
character.
Cannot start Edit mode.
A software error is preventing ElixiFont entering
Edit Bitmap mode. Exit ElixiFont and retry the
operation.
Cannot swap a character with itself.
You attempted to swap a selected character with
itself.
Changes cannot be undone.
This message is displayed if any software errors
occur during the undo process.
Character Blending error:
This message displays when a software problem
occurs during the creation of a new blended bitmap (in Edit Bitmap mode). Check disk space
and retry the operation.
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Character bitmap is corrupted.
Character bitmap was corrupted by transforming
or editing. Retry the operation.
Character corrupted during transform.
Character bitmap or record was corrupted by
transforming in edit mode. Retry the operation.
Character emboldening failed for Char <#>.
Emboldening the character resulted in the character using more than 4K of memory (4K is the
character limit). Reduce the size of the original
bitmap.
Character has changed. Do you want to exit without posting changes?
This message displays when you edit a character
in Edit Bitmap mode and attempt to exit Edit Bitmap mode before posting your changes.
Character is already NULL!
You are attempting to create a NULL character
from another NULL character.
Character is corrupted; cannot be transformed.
Character bitmap or record is corrupt. Retry the
operation.
Character resizing failed for Char <#>.
The bitmap is using more than 4K of memory (the
maximum allowed). Reduce the size of the
bitmap.
Character rotation failed for Char <#>.
This message displays when a software problem
occurs during the creation of a new rotated
bitmap.
Characters blended, click on POST to save.
Characters were successfully blended. Click on
[POST] to save the changes.
Character slanting failed for Char.
This message displays when a problem occurs
during the creation of a new slanted bitmap. Retry the operation.
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Character <XX> may extend beyond the boundaries of its cell. E(xtend), S(kip), or A(bort)?
During a font transformation, a transformed character may be larger than it's cell. User response
is required to extend the character cell, skip the
transformation for the specified character, or
abort the entire transformation.
Char is not printable.
This message displays while using the sampling
pad when you press any non-character key (for
example, the <Tab> key) or click on a NULL
character.
Choose the location to swap with.
This message displays when a character is selected for swapping and a second character must
now be chosen.
Choose the target location to copy to.
You have already selected source characters and
must now click on a target character.
Click on characters and move to blend.
This message displays in Edit Bitmap mode when
blending characters. The message informs the
user that both characters are displayed in the
framing window.
Click on the character in the window.
You clicked outside of cell frame in the framing
window.
Could not load screen font. Exiting...
A software error prevented loading the selected
font. Reload ElixiFont and retry the operation.
Could not load screen font <fontname>.
This message displays when the .FNT or .WDT
components of the SYSL and SYSH fonts (used
to display screen messages in low resolution and
high
resolution
modes)
in
drive:\ELIXIR\DESKTOP are corrupt. Check for
available disk space and reinstall ElixiFont.
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Current loaded font has not been saved. Save?
This message displays when the font was
changed and the user wants to load a new font or
exit ElixiFont before posting the changes.
Decimal point is not allowed.
Entering a decimal point is not allowed for the
current entry box. Retry the operation without
specifying a decimal point.
Delete selected characters? - Confirm deleting of
selected chars.
This message requests confirmation for deleting
one or more selected characters.
Device key checking.
ElixiFont is checking for the correct ElixiKey.
ElixiKey not detected; cannot save files.
The correct ElixiKey is not connected to the LPT1
parallel port and edited files cannot be saved.
Connect the correct ElixiKey to the parallel port.
Enter value higher than <value>.
The number entered is too low, enter a number
higher than the value displayed in the message.
Enter value lower than <value>.
The number entered is too high, enter a number
lower than the value displayed in the message.
Error occurred during reformatting.
An error occurred when transforming the font.
Retry the operation.
Error occurred in reversing this character.
A software error occurred. Retry the reversing
operation.
Error occurred in underlining this character.
A software error occurred. Retry the underline
operation.
Error occurred saving GLY file.
ElixiFont cannot save the .GLY component of the
font file. Retry the operation.
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Error occurred when blending character <#>.
A software error occurred in Edit Bitmap mode.
Retry the character blending operation.
Error occurred when changing the font resolution.
A software error occurred. Try changing the font
resolution again.
Error occurred when emboldening this character.
A software error occurred. Retry the emboldening function.
Error occurred when filtering this character.
A software error occurred.
Retry the filter
operation.
Error occurred when halftoning this character.
A software error occurred. Retry the halftone
operation.
Error occurred when mirroring this character.
A software error occurred. Retry the mirroring
operation.
Error occurred when outlining this character.
A software error occurred. Retry the outlining
operation.
Error occurred when saving .HDR or .GLH file.
ElixiFont cannot save the .HDR or .GLH components of the font file. Retry the operation.
Error occurred when setting character headers.
A software error occurred. Specify the character
headers again.
Error occurred when setting the font header.
A software error occurred. Redo the font header
operation.
Error occurred when shifting this character.
A software error occurred.
Retry the shift
operation.
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Error occurred when slanting this character.
A software error occurred. Retry the slanting
operation.
First select a character or a group of characters.
You attempted to select a tool without first selecting one or more characters.
Font changed from Fixed Pitch to Proportional.
This message informs the user that the width of
all character cells may be different after character
transformations.
Font has more than 256 characters. Truncate extra
characters? Confirm truncating.
This message displays when a attempting to load
a font that was converted from a non-Xerox format. If the original font contained more than 256
characters, the above message displays. Select
[Yes] to truncate the extra characters, or [Cancel]
to cancel the operation.
Font not loaded yet, press <F8> to load.
This message displays when attempting to perform a Save operation without first loading a font.
Load a font by pressing <F8> and selecting a font
from the displayed list.
Loading Font file...
This message is momentarily displayed when
loading a font.
Loading/saving files.
This message is momentarily displayed when
loading or saving a file.
Load target font first.
This message is displayed if loading a target font
for merging is unsuccessful. Close the loaded
font file and retry the merge operation from the
start.
Long fonts loading in XEROX toolsets.
This message is applicable only if both AFP and
Xerox versions of the Font Editor are loaded on
your PC. The message displays when selecting
to load a Xerox toolset.

ELIXIR GETTING STARTED GUIDE

A-61

TROUBLESHOOTING

Merge mode.
You selected merge mode.
Negative value is not allowed.
You attempted to enter a negative value in a numeric display box. Enter a positive value.
New font creating.
This message displays when creating a new font.
Operation interrupted. Would you like to continue?
You either clicked on the [Stop] button in the
Toolbox, or pressed a key during font
transformation.
Pick characters in the source Font.
This message displays when attempting to merge
characters from a source font to a target font
without first selecting one or more characters in
the source font.
Sample mode.
You selected the sampling pad.
Sampling Pad does not contain any characters.
You are attempting to print the sampling pad and
the pad does not contain any text.
Saving Font <name>.
ElixiFont is saving the font with the specified
name.
Screen font name not found.
This message displays when the .FNT or .WDT
components of the SYSL and SYSH fonts (used
to display screen messages in low resolution and
high resolution modes) are missing from
drive:\ELIXIR\DESKTOP. Check for sufficient
disk space and reinstall ElixiFont.
Second character is outside the Edit Bitmap area.
When blending characters in Edit Bitmap mode,
the second character is beyond the cell frame.
Reposition the character.
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Select a character or a group of characters.
You selected the Copy or Swap tools and did not
first select a character.
Select character for blending.
You selected the Blend tool in Edit Bitmap mode.
The attached ElixiKey is not valid for running the
Font Editor.
The ElixiKey connected to the LPT1 parallel port
is incorrect. Connect the correct ElixiKey and try
loading ElixiFont.
The character cannot extend beyond the left of the
cell.
To effectively extend a character beyond the left
edge of a cell, resize the cell.
The character is already blank.
You are attempting to create a blank (NULL or
SPACING) character from another blank
character.
The distance above, below, or leading has
changed. Do you want the line spacing adjusted?
You changed the [Distance Above], [Below], or
[Leading] fields in the Font Properties dialog box,
which affects their sum, the line spacing. The
message requests confirmation for adjusting the
line spacing value.
There are no characters after this one.
In Edit Bitmap mode, the user is attempting to
display the next character while the last character
of the font is displayed.
There are no characters before this one.
In Edit Bitmap mode, the user is attempting to
display the previous character while the first character of the font is displayed.
There are no more characters.
In Sampling mode, the user pressed the backspace key, but all characters on the pad were already deleted.
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There is nothing to Undo.
This message displays when the user clicks on
the Undo button before performing an operation.
This character cannot be enlarged again.
ElixiFont does not allow you to resize a character
repeatedly (because resizing errors are compounded). To resize again, exit Character Resizing mode and retry the operation.
This character could not be merged.
An error occurred during the transfer of the character bitmap or record. Retry the operation.
Too many characters in source font - will not fit in
target font.
This message displays when the number of characters in the source group you selected for copying or merging results in a target font that has
over 256 characters.
Too many decimal places.
This message displays when the user enters a
number with too many decimal places. Retry the
operation with fewer decimal places.
Transformation failed.
A software error occurred when performing the
transformation. Retry the operation.
Unsuccessful undo.
The Undo operation failed. Retry the operation.
Use mouse or keyboard to move selected area.
This message displays when the user has selected an area in Edit Bitmap mode.
Warning: cannot post this character.
This message displays when the character bitmap or record was corrupted by transforming or
editing and cannot be posted.
Retry the
operation.
You must enter a name for this font.
You did not specify an External Font name in the
Properties of New Font dialog box.
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Clipboard, 3-4
CONFIG.SYS, 2-2
configuration options
tape drive, 2-2
conventions, 1-7
display, 1-8
mouse, 1-9
typographical, 1-8
Converter icon, 3-7
converting files, 3-15
creating
fonts, 5-13
forms, 4-5
graphics, 6-6
customer support, 1-2

Clipboard, 3-4
converting files, 3-18
deleting files and
folders, 3-11
DOS access, 3-8
file management,
3-8
folder structure,
3-15
folders, 3-3
installation, 2-9
layout, 1-17, 3-2
menu bar, 3-2
overview, 3-1
using, 3-8
window, 1-17
Diskette icon, 3-6
Dispatcher icon, 3-7
documentation
accessing, 1-12
Acrobat Reader,
1-12
bookmarks, 1-14
directory, 1-12
navigating, 1-13
printing, 1-16
scrolling, 1-15
word find, 1-14
zoom in/out, 1-15
Documents folder, 3-4
DOS, accessing, 3-8

D

E

default installation
first time, 2-10
Desktop
applications, 3-4

edit window, 5-9
editing
fonts, 5-8
ElixiDoc, 3-5

Acrobat Reader, documentation, 1-12
application icons, 3-4
applications icons
ElixirImage, 3-5
AUTOEXEC.BAT, 2-2

B
batch utilities, 2-2
bookmarks, 1-14

C
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ElixiFont, 3-5, 5-1
basics, 5-1
creating fonts, 5-13
editing fonts, 5-8
framing window,
5-11
layout, 5-3
loading fonts, 5-6
menu bar, 5-4
modifying fonts,
5-13
saving, 5-14
Toolbar, 5-9
Toolbox, 5-5
using, 5-6
window, 5-4
ElixiForm, 3-5, 4-1
adding images, 4-10
adding text, 4-9
basics, 4-1
creating a form, 4-5
drawing boxes, 4-8
grid, 4-7
layout, 4-3
loading a form, 4-13
menu bar, 4-4
Message area, 4-5
modifying forms,
4-11
overview, 4-1
proof-printing, 4-13
rulers, 4-7
Toolbar, 4-4
Toolbox, 4-4
undo/redo, 4-10
window, 4-3
ElixiGraphics, 3-5, 6-1
basics, 6-1
creating graphics,
6-6
editing, 6-6
layout, 6-2
loading a file, 6-4
menu bar, 6-3
Message area, 6-4
overview, 6-1
proof-printing, 6-9
INDEX-2

resetting an image,
6-8
saving, 6-8
Toolbar, 6-4
Toolbox, 6-3
Transform tool, 6-7
using, 6-4
window, 6-2
Elixir applications
conventions, 1-7
exiting, 1-19
forms creation advantages, 1-19
Help, 1-10
system requirements, 1-4
Elixir Web site support,
1-4
ElixirDoc icon, 3-5

F
file conversions, 3-15,
3-18
files
AUTOEXEC.BAT,
2-2
CONFIG.SYS, 2-2
converting, 3-15,
3-18
deleting, 3-11
duplicating, 3-13
management, 3-8
moving, 3-10
overwriting, 3-14
renaming, 3-12
selecting, 3-9
TAPE_MT0.SYS,
2-2
folder directories, 3-3
folder structure, 3-15
fonts
basics, 5-2
character components, 5-2
creating, 5-13
editing, 5-8
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loading, 5-6
saving, 5-14
transforming, 5-12
Fonts folder, 3-3
forms
creating, 4-5
proof-printing, 4-13
Forms folder, 3-3

G
graphics
creating, 6-6
editing, 6-6
loading, 6-4
proof-printing, 6-9
saving, 6-8
Graphics folder, 3-4
grid, 5-10

H
Help, on-line, 1-10

I
icons, 3-3
ElixirImage, 3-5
installation
before installation,
2-1
custom, 2-11
default, 2-10, 2-11
first time installation,
2-9

J
Jobs folder, 3-4

L
licensing software, 2-3
lines
coloring, 4-8
loading
fonts, 5-6
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forms, 4-13
graphics, 6-4
new forms, 4-6

M
magnification, 5-10
memory requirements,
1-6
Message area, 4-5, 5-5,
6-4
modifying
fonts, 5-13
forms, 4-11
graphics, 6-6
mouse, 1-9

O
on-line documentation
accessing, 1-12
Acrobat Reader,
1-12
bookmarks, 1-14
directory, 1-12
navigating, 1-13
printing, 1-16
scrolling, 1-15
zoom in/out, 1-15
Online documentation,
1-12
overview
Desktop, 3-1
ElixiFont, 5-1
ElixiForm, 4-1
ElixiGraphics, 6-1

P
Printers icon, 3-6
printing
documentation, 1-16
proof-printing
forms, 4-13
graphics, 6-9
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R

U

registering software, 2-3
Release notes, 1-2
requirements
ElixiKey, 2-1
hardware, 1-5
software, 1-6
system, 1-4
resetting an image, 6-8

User Files icon, 3-4
User Tools icon, 3-6

S
saving
fonts, 5-14
forms, 4-12
graphics, 6-8
Scanners icon, 3-6
software registration, 2-3
software requirements,
1-6
support, customer, 1-2,
1-3
Support, Web site, 1-4
system requirements,
1-4

V
Viewer icon, 3-7

W
word find, 1-14

X
XWIN.log
installation, 2-9

Z
zoom in/out, 1-15

T
TAPE_MT0.SYS, 2-2
tape drive configuration,
2-2
Tape icon, 3-6
Toolbar
ElixiFont, 5-9
ElixiGraphics, 6-4
Toolbox
ElixiFont, 5-5
ElixiForm, 4-4
ElixiGraphics, 6-3
toolsets, 1-6
Transform tool, 6-7
Transformer icon, 3-7
Transforming fonts, 5-12
Trashbin icon, 3-7
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